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Where can I go to learn more about ImagePrint?

Users Guide: The ImagePrint user’s manual is the first place to find information about the various tools and fea-
tures available within the software.  The manual is installed in your ImagePrint folder. The default location is: 

 	 / Applications / ImagePrint / ImagePrint Manual.pdf

You can access the manual by choosing ImagePrint Users Manual from the Help menu within ImagePrint. The lat-
est revision of the manual is also availabe on our web site’s (www.colorbytesoftware.com) Support page.  The man-
ual is large and comprehensive, and is often best used as a general reference rather than read cover-to-cover.

Training Movies: Sometimes you need to see a feature in action in order to understand it. The animated 
training movies located on our web site: www.colorbytesoftware.com can be incredibly useful in that regard.  
Demonstrations of the Templates feature, Layout Schemes and Border Browser are currently available, among 
many others.

Users Group: The Yahoo ImagePrint Users Group is a great source of information about ImagePrint.  Users of the 
software share their advice, tips, solutions (and complaints) in an often lively discussion.  Many of the participants 
are long time users of ImagePrint and gurus in the ways of printing.  To access the group use the following link:

 	   http://tech.groups.yahoo.com/group/colorbyte_imageprint/

Workshops, trade shows, seminars: While ColorByte doesn’t currently produce workshops or seminars, there 
are existing ones that utilize and teach with ImagePrint.  Also, ColorByte personel sometimes appear at industry 
trade shows or participate in dealer seminars.  For information on upcoming events in your area, contact the sales 
department at: 

 	 sales@colorbytesoftware.com

Updates: The latest build of ImagePrint can be found at the ColorByte update site:

 	 www.colorbytesoftware.com/update.htm

For more information on updating, see Updating ImagePrint

http://tech.groups.yahoo.com/group/colorbyte_imageprint/
mailto:sales@colorbytesoftware.com
 www.colorbytesoftware.com/update.htm 
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Installation, Uninstallation Issues
This section is devoted to issues and questions related to installing, uninstalling, or launching ImagePrint.

Re-installing your ImagePrint printer driver - A basic walkthrough

Sometimes reinstalling your printer driver is the quickest solution to a stubborn problem.  The IP Setup utility, 
located in your ImagePrint folder, can be used to remove and reinstall your ImagePrint printer(s).  

Follow the below instructions to remove and reinstall your ImagePrint printer driver.

•	 Make very sure that ImagePrint, and Spoolface, are NOT running (Important!)

•	 Launch IP Setup by double-clicking it from within your ImagePrint folder in your Applications folder.

Please do not worry that the left side of the IP Setup window does not show your printer.  This is nor-
mal. Your installed printers are listed on the right side under the INSTALLED PRINTERS heading.

•	 Choose the installed printer on the RIGHT side of the window by clicking on it, then click REMOVE to 
remove it.    (IMPORTANT NOTE--This will delete all your old print jobs from Spoolface.  If you wish to 
keep those old jobs you may skip this step, although it may reduce the chances of this procedure correct-
ing your problem)

•	 Choose the PRINTER type from the drop-down menu on the left.

•	 Make sure HOST Computer Install is selected unless you are setting up a remote (client) workstation.  
(If this computer is the one with the USB dongle attached, then you are installing as a HOST)

 1. If you are connected via USB or Firewire (OSX 10.4 only) to the printer: 

Click “Local”, then choose USB or Firewire in the Connection section of the window

2. If connected via ETHERNET to the printer:

Click the NETWORK button, and enter the IP Address of the PRINTER in the fields provided 
(If you do not know the printer’s IP Address, consult the Networked Printer Settings section 
later in this guide--it is vital to provide the right printer ip address in order for printing to occur).

•	 Click INSTALL in the IP SETUP window.

Note: If you have already entered your encryption and licensed the printer previously, you most likely will not 
need to put your encryption number in again or click License---if the printer listed on the right side of IP Setup 
has the word LICENSED after it, then it is already licensed--close IP Setup, launch ImagePrint, and try a print.

If it does not show LICENSED at the end of the printer line on the right side of IP Setup, you will need to put 
your encryption into the encryption field and click the LICENSE button. (Make sure the dongle is attached to 
the computer and the dongle number shows up in the “Dongle Number” field).

  

 
Consult the appropriate section of this guide if a problem or error occurs with any of the above proce-

dures. 
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What Macintosh OSX version is my copy of ImagePrint compatible with? 

Following is a list of current Macintosh OSX operating systems and the versions of ImagePrint they are 
compatible with.  To check the build number of ImagePrint, launch ImagePrint and choose “About This 
Application” from the the ImagePrint menu.

 OSX 10.2x (Jaguar) or OSX 10.3x (Panther) - All versions of Imageprint prior to 6.1.  
 							        (NOT supported by ImagePrint 7.0)

 OSX 10.4.X (Tiger)	 	 	 	  ImagePrint 6.1 and 7.0 and 8.0

 OSX 10.5.X (Leopard)		 	 	  ImagePrint 7.0 (build 1.0.1.5 and later) and 8.0

If your copy of ImagePrint is incompatible with your Operating System, you will need to update the software 
in order to use it on that OS.  Depending on your current ImagePrint version, updates may be free or may 
need to be purchased.  To find out your current upgrade eligibility and applicable pricing, send an email 
request including your dongle number to:

 sales@colorbytesoftware.com

 The latest build of ImagePrint can be found at the ColorByte update site:

 		  www.colorbytesoftware.com/update.htm

 For more information on updating, see Updating ImagePrint

I downloaded the installer and it doesn’t launch

Incomplete download: The ImagePrint installer for the Mac is large (over 100 megabytes). Make sure it has com-
pletely downloaded to your computer before attempting to launch it--depending on your download speed and the 
traffic on the ColorByte web site, the download can take anywhere from 30 minutes to several hours.

Didn’t remove the previous version: The installer will fail to complete if an ImagePrint folder already exists in your 
Applications folder.  Remember that the ImagePrint installer is always a full install--make sure to remove any previ-
ous ImagePrint installations by dragging the old ImagePrint folder to the trash as outlined in the Quickstart guide or 
user’s manual--and make sure to empty the trash afterwards!  

HINT: If you already have ImagePrint 7.0 or 8.0 on your computer, you may want to download and run the 
Easy Installer instead of the Full Installer--the Easy Updater will update a prexisting version of ImagePrint to 
the latest.

IMPORTANT: After each failed installation attempt, check your /Applications folder to see if an ImagePrint folder has been created.  If so, 
delete the folder before retrying the installation.

Make sure you’re launching it correctly: The installer will be downloaded as a Macintosh disk image (.dmg).  This 
type of file simulates a physical drive like a cd-rom.  Once you have downloaded the installer, double-click it and the 
disk image will “mount”, just as if you put a cd in your cd drive (you’ll see an icon on your desktop appear, similar 
to the way a cd icon appears when you insert a cd).  You should also see a window open up with the ‘ImagePrint 
Installer” application in it--double-click that file to begin the installation process.  

Make sure to follow the Quick Start guide, available from the location on the web site where you downloaded the 
installer, as a guide to installing the software. 

sales@colorbytesoftware.com 
 www.colorbytesoftware.com/update.htm 
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Installer stops, never getting to the IP Setup screen

Possible causes and solutions for this condition: 

IMPORTANT: Always make sure to check your /Applications folder to see if an ImagePrint folder has been cre-
ated from the previous installation attempts.  If so, delete the folder before retrying the installation.

Didn’t remove the previous version: The installer can fail to complete if an ImagePrint folder already 
exists in your Applications folder.  Remember that the ImagePrint installation is always a full install--
make sure to remove any previous ImagePrint installations by dragging the old ImagePrint folder to the 
trash as outlined in the Quickstart guide or user’s manual. Make sure to empty the trash afterwards.

Didn’t specify that program files be installed: If this is a cd install and you did not choose the 
“Application files” checkbox at the top of the components list in the ImagePrint installation only color pro-
files will be installed--no application files.  Remove the ImagePrint folder (if it exists) in your Applications 
folder, then install the software again, making sure that the top checkbox is selected in component’s list 
(it’s the screen that comes right after the License Agreement).  The printer names listed in this window 
just refer to the color profiles you wish to have installed.

Empty Trash: Try emptying the trash.  Sometimes OSX can follow links to files in the trash which can 
cause problems.

Problem with CD-ROM: If you are installing from cd, you may have a problem with the cd, or your cd 
drive may have compatibility issues preventing it from reading the cd.  (If you see any “media” errors 
this is most likely the case).  See the section later in this guide: Problems with the CD-ROM for infor-
mation on this issue.

Problems with the CD-ROM

If installing ImagePrint via CD-ROM, some errors may be due to problems with the physical CD-ROM disk.  
Any “media” errors generated by the system are a possible sign that this is the problem.  Below are some 
things to try to get around disk problems:

•	 Check the CD for cracks or other obvious defects.  Clean the disk if you see any smudges or finger-
prints.

•	 Try copying the Installer from the CD to the desktop of your computer.  If you can do this without an 
error, then run the Installer from the desktop.

•	 Try copying the Installer from the CD on another computer.  If this works, it indicates a compatibility 
issue with the CD drive on the first computer.  Copy the installer from the 2nd computer to the first and 
use it to install.

•	 It’s possible the problem with the CD may only exist in some areas of the disk.  Since printer profiles 
take up the majority of the CD, try installing just the program files (you do this by making sure only 
“Program Files” is selected at the top of the screen with the list of printer names next to checkboxes.  
(You can always download the profiles later via our Profile Manager.

•	 Finally, remember you can download the full installer from our update site on the internet.  Since we 
update the software occasionally it’s likely your CD will become obsolete eventually anyway.  Installing 
from the downloadable installer or Easy Updater is the best way to stay up to date.  Check the section 
of this guide entitled: How do I Update ImagePrint for more information on downloading the installer.
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“Couldn’t Connect Socket in IP Config” error when installing, enabling, or launching the soft-
ware

This common error may occur when installing a printer via IP Setup or when clicking LICENSE after typing 
in your encryption number.  It indicates that ImagePrint’s internal communication is being restricted by the 
Operating System.   Sometimes, this just means you need to reboot your system to let the changes made by 
ImagePrint’s installation process take effect.  If rebooting fails to correct the problem, read the following for pos-
sible solutions:

FIRST - Run the Socket_Fixer utility : Located in your ImagePrint folder (/Applications/ImagePrint) you 
will find a disk image filed named: Socket_fixer.dmg.  Double-click this file to mount the disk image, then 
follow the on screen instructions to launch and run the Socket_Fixer utility.  Once done, reboot your com-
puter and resume the installation by launching “IP Setup” from the /Applications/ImagePrint folder..  In the 
vast majority of cases, this will have fixed any Socket Errors.

	Easy Updater: If you do not have the Socket Fixer utility in your ImagePrint folder, or it fails to correct the 
problem, the ImagePrint 8.0 Easy Updater will not only update your software to the latest build without 
need for reinstalling or losing your settings--it will also “refresh” your installation and solve many common 
problems including socket errors.  If you are currently using ImagePrint 7.0 or 8.0, try downloading and 
running the updater from our update site: www.colorbytesoftware.com/update.htm.

Incompatible OS Version: If on OSX 10.5.x (Leopard) you must be using ImagePrint version 7.0, build 
1.0.1.5 or ImagePrint 8.0 (any build).  Previous versions will not run. (Check the build via the ImagePrint 
menu. To update see Updating ImagePrint)

	Macintosh Password: The “Couldn’t Connect Socket” error is sometimes due to having incorrectly entered 
your Macintosh password when prompted during the ImagePrint installation. During normal installation on 
Leopard systems a Macintosh Terminal window will appear immediately before the IP Setup window.  Do 
not ignore this window--it is a necessary validation step.  Within the window will be text requesting that 
you input your Macintosh password.  You will not see any characters as you type them--just type in the 
password and hit return.

System Updated:  The Couldn’t Connect Socket error may appear after your operating system has been 
updated.  This can cause certain system files that ImagePrint depends on to be overwritten.  Try using the 
Socket Fixer utility, or the Easy Updater, as mentioned earlier.  If the error perists, you should fully remove 
and reinstall ImagePrint according to your original installation instructions. Remember, only ImagePrint 7.x 
(build 1.0.1.5 or later) will run on Leopard (OSX 10.5.x)

Moved or migrated to a new computer:  Moving ImagePrint from one computer to another is not support-
ed and will result in this error due to system level files not be available.  You must fully install ImagePrint 
from cd or downloaded installer--it cannot be migrated or moved.

www.colorbytesoftware.com/update.htm.
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“Wrong Response from Driver” error during installation or when launching ImagePrint

Leopard cached library problem: On OSX 10.5.x systems, this error most often means that the Leopard OS 
isn’t allowing ImagePrint to update some system libraries properly.  Try the following procedure to correct the 
problem: 

•	 Open a Mac terminal window by going to the  /Applications/Utilities folder and double-clicking “Terminal”

•	 In the terminal window that appears, type the following command (or copy and paste it from this email):

					    sudo update_dyld_shared_cache -force

    	It will ask for your Mac password.  Type that in (it won’t show it as you type) and hit return.

    There should be no errors at all after entering this command  If you see an error, something was likely 
typed incorrectly--try again, making sure to pay attention to the spaces.

•	 Once you have successfully entered that command with no errors, try running IP Setup again (make 
sure ImagePrint and spoolface are NOT running) and remove, then reinstall the printer.

Missing driver: There may be a problem with the driver file for the printer you are installing, or with permis-
sions to the folder that contains the driver.  The driver files are located in the DRIVERS folder within the 
Imageprint folder.  If that folder has been moved or any files deleted from it, you may get this message.  Be 
careful when checking the folder--some printers use drivers named for other printers.  For example, the Epson 
9600 shares the “Epson 7600” driver file, so you won’t see a 9600 driver file listed in the DRIVERS folder.  If 
you suspect files have been removed from this folder, the best solution might be a full install (from CD-ROM 
or downloaded installer).

Permissions on the ImagePrint folder: Restrictions on access to the ImagePrint folder may also cause this 
error.  Follow the procedures in the entry elsewhere in this guide: Opening permissions on the ImagePrint 
folder.

Uninstalling ImagePrint 

To uninstall ImagePrint, simply drag the ImagePrint folder from its location in your Applications folder to the 
trash.   Prior to doing that, you may want to back up your color profiles if you plan to use them with a fresh 
copy of ImagePrint.  To back up your Color profiles, simply drag the folder called “Color” from the ImagePrint 
folder to your desktop.  You can then delete the ImagePrint folder and, after installing the new copy of 
ImagePrint, drag the desktop “Color” folder to the new ImagePrint folder (within the Applications folder) to 
overwrite the new folder with your previous one.

Whenever I launch IP Setup, it doesn’t show my installed printer on the left side  

Installed printers show up on the RIGHT side of IP Setup.  The LEFT side will always show the default entry 
since it is ready for you to install additional printer drivers.  This is normal behavior.  Do not needlessly rein-
stall by clicking the Install button if the printer(s) already shows up on the right side.



T15 IMAGEPRINT 	 	 	                            Troubleshooting

ImagePrint Macintosh Troubleshooting Guide (Cont.) Back to Table of 
Contents

Back to Table of 
Contents

After Installation, only a Color folder exists in the ImagePrint folder 

This is a result of not having chosen the “Program files” checkbox at the top of the components list in the 
ImagePrint installation.  Install the software again, from the CD, and make sure that the top checkbox is 
selected in this screen (it’s the screen that comes right after the License Agreement).  The printer names 
listed in this window just specify which color profiles you wish to have installed--the “program files’ checkbox 
refers to the actual ImagePrint program itself.

No ImagePrint icons appear on my dock  

Dock Shortcuts are NOT created automatically during installation.   In order to create dock icons, you should 
navigate to the ImagePrint folder, which is located in the Applications folder.  Within the ImagePrint folder you 
should locate the ImagePrint application (its icon will be the “circle-in-a-square” ImagePrint logo), and drag it 
to the dock.   Be careful--only drag the icon to the dock, do NOT drag the application to the desktop or 
a folder or you will have improperly moved ImagePrint from its required location.   

Some users also create a dock icon for SpoolFace for quick access to the ImagePrint spooler.  To do this, drag 
the SpoolFace icon from the SPOOL folder within the ImagePrint folder to your dock.

“Couldn’t Open IP Batch in Make Interface File” error during installation

This error can happen if you have a space in the name of the printer specified in the IP Setup window when 
installing.  Try installing again, with no spaces in the printer name.

The problem can also be caused by permissions issues on the system.  Try opening up permissions on the 
ImagePrint folder by following the instructions in the section of this guide entitled: Opening up permissions 
on the ImagePrint folder. 

MPI Shared Library Error when launching or installing ImagePrint   

That means that the dongle library package didn’t install correctly during the initial phase of the install.  This 
package can be installed manually by launching the “mpi.pkg” file in the ImagePrint folder.  It will ask for the 
Macintosh password, then the volume (hard drive) you are installing.  Once it has completed its installation, 
reboot your computer and the problem should be resolved.



T16 IMAGEPRINT 	 	 	                            Troubleshooting

ImagePrint Macintosh Troubleshooting Guide (Cont.) Back to Table of 
Contents

Back to Table of 
Contents

Networked Printer Settings

(The following information is taken from the Appendix of the ImagePrint manual)

Getting the Printer IP Address

When printing to a printer via an ethernet connection, the TCP/IP communication protocol will be used, which 
depends on each device on the network having a valid, unique IP Address. 

You will need to provide the IP Address of the printer to IP Setup during installation so ImagePrint can 
communicate with it at print time.  Although different printers and network cards may vary, some method of 
accessing the ip address, either by printing a status page or via the front panel of the device, will be available.

Front Panel: Many new printers allow you to see and specify the IP Address via the front panel controls on 
the printer.  Consult your printer’s manual for instructions for how to do this.

Status Page: In cases where you are not able to use the front panel to set the IP Address, check for a small 
or recessed button beside the port where the network cable plugs into the printer.  Pushing this button for 
one second will cause most printers to output a page showing their current settings, including the IP Address. 
(Make sure to load scrap paper on the printer--not expensive art paper!)

The IP Address will consist of 4 numbers, each between 0 and 255, separated by periods.  This is the number 
you will need to use in the Network fields when installing the printer with IP Setup.

Checking TCP/IP connectivity

Once you have the printer’s IP Address, type it into the address field of a web browser (like Internet Explorer, 
Safari or Firefox). Just type the 4 numbers of the ip address, separated by periods, into the address field--no 
other text (like http://) is needed.  You should see the Printer’s HTML setup screen appear in the browser win-
dow. Using a web browser in this way is a good test of your computer’s TCP/IP connectivity to the printer--if 
the browser fails to show the printer’s setup screen, then you know you have a TCP/IP communications prob-
lem of some sort, or have an incorrect ip address for the printer.  

Note: Even if you can print to the printer via the manufacturer’s driver, it does not necessarily mean you have 
TCP/IP communication to the printer.  TCP/IP is required by ImagePrint when printing to a printer connected via 

Ethernet but other protocols may be used by other drivers and RIPs.

Different IP Address sub-nets between printer and computer: Communication problems can arise if the 
IP Address numbering scheme of the printer is different than that of computer.  For example, if the printer’s 
IP Address is: 192.168.0.12, and your computer’s is 30.40.16.8, then it is likely there will be no communica-
tion via TCP/IP between the devices.  Compare the IP Address of your computer to that of your printer.  If the 
first 3 sets of numbers are not the same, this may be the problem (the last number should always be unique 
for each device). In cases where the network schemes differ, you may not be able to communicate with the 
printer until the IP Address is changed to one that is compatible with the rest of your network. 

You can check the ip address of your computer on Macs via the Network Control Panel in System Preferences, 
on PC’s it is available in the TCP/IP properties of your network card.

Continued on next page
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Changing the printer’s IP Address (if needed)

Front panel: If the printer allows you to change the IP Address via the front panel on the printer, changing the 
address is relatively easy--consult your printer’s manual for instructions.

Manufacturer’s utility: In cases where you can’t set the IP Address via the front panel,  you may need to use a 
setup utility provided by the manufacturer.  For Epson printers, the Net Assist utility is used to setup the network 
parameters on your printer.  That utility is provide on the Epson printer setup cd’s, and is also available for down-
load from the Epson web page.

Reset the printer to factory defaults: If your network uses a router, another method of changing the printer’s IP 
Address is to reset the printer to its factory default settings by holding down the recessed button on the network 
card of the printer while turning the printer off, then on.  When the printer comes back up, it will default to DHCP 
mode, which will cause it to get a new IP Address from the router which should then be correct for your network.  
Press the recessed button again (for 1 second) to output a new status page showing the current IP Address and try 
to reach the again with the new IP Address in a web browser.

Setting the printer to a Manual (Static) IP Address

Once you have the printer’s IP Address (and have used it to specify the connection to the printer in IP Setup), it is 
important that this IP Address doesn’t change in the future.  Otherwise, ImagePrint will no longer be able to find the 
printer.  An IP Address that doesn’t change is called “Static”, or “Manual”.

To set your printer to a Manual IP Address, log into the printer via a web browser as described earlier in this section 
by putting the IP Address of the printer into the browser’s address field and pressing the return key.  If the printer is 
reachable on your network, you should get a login window, with access to the printer’s configuration settings.

Once you are on the printer’s setup page, you need to specify the “Method for Acquiring the IP Address”.  For 
most printers this setting is in the TCP/IP portion of the  Configuration section of the Printer Setup window, howev-
er the specific location and terminlogy may vary for some printers.   The choices are typically:   AUTO or MANUAL  
Make sure it is set to MANUAL to prevent the IP Address from changing each time the printer is restarted.  After 
changing the setting (if necessary) apply the settings--usually that is done via the SUBMIT button at the bottom of 
the setup screen.  

Note: Most printer setup screens will ask for a user name and/or password when applying new settings.  Unless you 
have previously set a password for your printer, the entries should be left blank for most printers as that is the default 
username and password.  If that fails, try using the name “admin” for the username and nothing for the password.
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Opening up Permissions on the ImagePrint folder

Automatically via the Easy Updater

The Macintosh Easy Updater utility, available from the ImagePrint Update site, will open permissions 
on the ImagePrint folder.  Just go to: www.colorbytesoftware.com/update.htm and download the Easy 
Updater (not the Full Installer), then double-click it to run it. When its finished, permissions on the 
ImagePrint folder will be fully open. 

Through the Mac Terminal:

To open up read/write permissions on the ImagePrint folder manually:

Open a Macintosh Terminal by double-clicking the Terminal application from within the 

 /Applications/Utilities     folder

When the Terminal comes up, type (or paste) the following line, then hit the RETURN key:

 sudo chmod -R 777 /applications/imageprint

            (BE VERY CAREFUL ABOUT SPACING AND SPELLING!)

It will usually ask you for your Macintosh password--type that in, and hit the Enter key (note that, when 
typing in your password, no characters will appear on screen--this is normal behavior on the Mac for 
security reasons).

After pressing Enter, check that no errors were reported, then close the Terminal window. 

NOTE: You should get no error messages after hitting the Enter key.  If you do see any errors, you prob-
ably entered the password incorrectly, or typed the command in incorrectly.  (If you get an error indicating 
that you do not have sufficient permissions to run the “sudo” command, you should log in as a user with 

Administrative priviliges).
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How do I update/upgrade my software?

The latest version of ImagePrint is always downloadable via the internet.  Depending on the version of the software you 
are using and your current support status, these downloads may be free, or may need to be purchased from ColorByte.  
(In most cases, new updates (or revisions) of your current version are free to download regardless of your support status, 
but upgrades to the software that alter the version number (i.e., from 6.1 to 7.0) are feature upgrades and require pur-
chase). 

Determining your Version and build (revision) number 

To check the version and revision number of your copy of ImagePrint:

 Macintosh - Choose “About ImagePrint” from the ImagePrint menu

 Windows - Choose “About...” from the ImagePrint Help menu

!! Do not attempt to install or upgrade your software if you do not already have a valid ImagePrint encryption for 
the new version or the software will run in demo mode (putting the word DEMO on your prints). 

Download Location

The latest version of Imageprint is available at the ImagePrint version 8.0 update site:

 www.colorbytesoftware.com/update.htm

Update Procedure

An Update guide in Acrobat (PDF) format is available from the ImagePrint update site---make sure to download it 
for instructions on installing the software. 

Easy Updater: Updates can usually be done via our downloadable “Easy Update” utility without having to remove/
reinstall the software if you already have the current version (8.0) or the previous version (7.0) installed on your sys-
tem.  For example, if you have ImagePrint 8.0, build 1.0.0.0 installed, and want to get Imageprint 8.0’s latest build, 
the updater can be used.  

Important information on updating from version 7.x to 8.x with the Easy Updater:  Updating from a pervious version 
(7.0) to 8.0 will update your software to 8.0 but it is important to remember that 8.0 requires a different encryption 
number than 7.0, so only do this if you have purchased and received an 8.0 license---otherwise, after updating 
you will only be able to run ImagePrint in DEMO mode (printing the word Demo on all output).  Also, while most of 
your settings will be preserved when running the Easy Updater, some will not be--for instance, after updating from 
7.0 to 8.0 via the easy updater, you will need to reselect your printer/paper profile in the Color Management window. 

Full Install: On systems that do not already have ImagePrint 8 or 7 installed, the full downloadable installer must be 
used and any old versions of ImagePrint should be removed prior to installation of the new one.  Follow the update 
guide, available on the Update site, for more details.

Upgrade Eligibility and Pricing

To check your status, send an email (including your dongle number!) to: upgrades@colorbytesoftware.com

Upgrade pricing depends on your printer license(s) and how long you have had the software since last updating.  
For pricing information, email our sales dept. with your dongle number at:  sales@colorbytesoftware.com

www.colorbytesoftware.com/update.htm
mailto:upgrades@colorbytesoftware.com
mailto:upgrades@colorbytesoftware.com
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Encryption, Dongle and Demo Mode Issues
ImagePrint licensing problems and solutions are listed in this section

How do I get my encryption number?

In order to enable your software to print in non-demo mode, you must first license it.  

Licensing is done via an encryption number (19 to 21 digits in length) which is specially made for your unique dongle 
number and the printer(s) you are using with ImagePrint. This number must be entered into the encryption field of IP 
Setup after installing the printer.  When the License button is pressed, the installed printer will show “Licensed” and 
you’ll be ready to print.  

To get your encryption number, you must use the ColorByte license server web page.  This server is available on the 
internet 24 hours a day, 7 days a week.  

To use the ColorByte encryption server web page, you will need 3 things:

1.	Your unique 6 digit dongle number.  

		 This number is provided on the dongle itself, as well as on the label on the back of your software cd case.  It 
will also be listed in any upgrade emails you receive from ColorByte.

2. The 6 letter login code for each printer type you will be using with ImagePrint.  

		 This login code can be found on the back of your original cd case, but be careful.  That code will be for the 
version of ImagePrint you’re original cd was created for.  If you have updated to a new version, use the 
login code you recieved in the emailed upgrade instructions from Colorbyte.  
 

Remember--login codes are specific to the version of ImagePrint you are using--do not use an older login code 
to get an encrytpion for a later version of ImagePrint or you will just re-receive the previous versions encryp-
tion code. Previous version’s fail to license the software, or cause it to print in demo mode.

		 Multiple printers: If you have purchased multiple printer licenses for the same category of printer (for example, 
two 17 inch printers such as an Epson 3800 and an Epson 4800) then you will have one single login code that 
is good for two printers.   

3.	A valid email address

Log on to the ColorByte encryption server by clicking the following web address or by pasting it into your web brows-
er’s address  bar and pressing the return key:  www.colorbytesoftware.com/getcode.php

Note: Do not type the above address into a search engine such as Google.  Put it in the address bar of the browser.

You will be taken to a page containing fields for the 6 digit dongle number, the 6 letter login code, and the email 
address the encryption should be sent to.  After filling out those fields, click Submit to have the encryption emailed to 
you.  You will usually receive the email within 5 minutes.

If you don’t receive the email:  Check for any junk mail filters on your computer or in use by your Internet Service 
provider---in most cases, instances where the encryption email is not received are due to them being misinterpreted 
as junk (spam) mail by such systems.

There is no limit to the number of times you can use the encryption server, and you can use it with a different email 
address if you have problems with your original email one.  Just make sure to use the correct login code for  your ver-

sion of ImagePrint (i.e., don’t use your version 6.1 login code if installing version 7.0).

http://www.colorbytesoftware.com/getcode.php
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Problems starting or using ImagePrint
Problems related to launching or using the ImagePrint interface are listed in this section

ImagePrint won’t launch

•	 Reboot: (It’s a tech support cliche, but sometimes rebooting actually works).

•	 Run the ImagePrint downloadable Easy Updater: The ImagePrint Updater utility, located on the ColorByte 
ImagePrint 7.0 Update web page, can be used to update your software to the latest build as well as correct 
many common problems related to ImagePrint not launching.  Even if you are on the latest build or have 
just installed the software, running the updater will solve most problems with launching the software as it will 
ensure that the proper libraries and system files are in place.  The updater does not require a reinstallation of 
the software, and does not affect your current settings 
 
To get the Easy Updater, download it from:

 	 www.colorbytesoftware.com/update.htm

•	 Bad Profiles in Color folder: Make sure there are no invalid profiles, non-profiles, or sub-folders, in the 
COLOR folder within the ImagePrint folder. Only valid ICC/ICM profiles should be in the COLOR folder.  (If you 
have added profiles to this folder prior to the problem, try removing the added profiles to see if it corrects the 
issue).

•	 Monitor Profile: The system monitor profile often causes this condition.  To test if this is the problem, access 
your Macintosh System Preferences (under the Apple menu icon) and choose Displays.  In the Color section 
of the Displays panel temporarily change the System Monitor profile to a standard working space (such as 
Adobe 1998).  Remember the previous profile you were using so you can return to it later.  Then try launch-
ing ImagePrint again.  If it works, there may an issue with your monitor profile or the Mac may have simply not 
“seen” it even though it appeared to be selected. Try explicitly selectinig the original monitor profile again to 
see if it now works.  

•	 Bad Preferences File: If you are getting an “Unexpectedly Quit” message, try deleting the ImagePrint prefer-
ences file (and emptying the trash!).  This file is called com.colorbytesoftware.imageprint 7.0 plist and is in 
the folder:  / users / ”user name” / library / preferences.   (Note: If you have never successfully launched 
ImagePrint, this file may not exist).

•	 Assistive Devices: Check the UNIVERSAL ACCESS panel in System Preferences (under the Apple Menu) 
and make sure “Enable access for assistive devices” is UN-checked.

•	 Moved ImagePrint folder: Make sure that the ImagePrint folder has not been moved or renamed.  This folder 
must stay in your Applications folder  or the software will not run.

•	 Couldn’t Connect Socket in ip config: If you are getting a “Couldn’t Connect Socket” error when attempt-
ing to start ImagePrint, check the earlier entry in this guide entitled: Couldn’t Connect Socket

•	 Wrong Response from Driver: If you are getting a “Wrong Response from Driver” error when attempting to 
start ImagePrint, check the earlier entry in this guide entitled: Wrong Response from Driver	

•	 Shared Library Failure: If you are getting a “Shared library failure” error when attempting to start ImagePrint, 
check the earlier entry in this guide entitled: MPI Shared Library Failure.

•	 Can’t Query “Printer driver”: If you are getting an error related to not being able to Query the printer driver, 
it means ImagePrint is not able to contact the driver for the printer in our Drivers folder.  Sometimes this can 
occur occasionally on older computers, or computers with problems with the TCP/IP protocol.  Trying to launch 
ImagePrint again may work.  If it repeatedly fails, try rebooting the computer.

•	 Launching from a Bad Alias: Make sure that you are launching the application from either a valid ImagePrint 
alias, a dock icon or directly from the ImagePrint folder.  Do NOT move ImagePrint’s application files to a dif-

Continued on next page
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JPEG files won’t open (or open very slowly)

•	 Make sure to check the general question regarding File Names earlier in this document--nothing but letters, spac-
es, underlines, hyphens and periods should be in the file name

•	 Try re-saving the JPEG file from Photoshop, and make sure NOT to use “PROGRESSIVE” as the JPEG compres-
sion format.

 

JPEG files are opening and printing at the wrong size! 

Currently, ImagePrint treats all JPEG files as 300 PPI.  This is to avoid problems because of incorrect dpi data that 
sometimes is saved by Digital Cameras.  If they were created at a different resolution, try re-saving them at 300 PPI 
to correct the size problem, or save them as TIFF or PSD files, which will use the correct dpi setting for the image.

TIFF files won’t open (or open very slowly)

•	 Make sure to check the general question regarding File Names earlier in this document--nothing but letters, spac-
es, underlines, hyphens and periods should be in the file name.

•	 Make sure compression is not used when saving your images.  ZIP compression is often turned on for no 
discernible reason in Photoshop CS 3 even when it had previously been turned off so don’t assume that it is off if 
you’ve never accessed it.  Do a “Save As...” in Photoshop on your image to ensure that no compression is used.

•	 The Pixel Order can also cause images not to open, or to open and display incorrectly or to open and print 
very slowly.  In Photoshop’s “Save As...” dialog, in the TIFF options section, make sure the Pixel Order is always 
INTERLEAVED, never “Per Channel”.  

•	 Alpha Channels: ImagePrint does not support non-color channels in TIFF files.  Make sure that no extra channels 
are present in your image.  To check for extra channels, open the file in Photoshop.  Choose CHANNELS under 
the Photoshop Windows menu.  In the Channels palette that appears, you should only see the standard  color 
channels (i.e., R,G,B for an RGB image).  Delete any extra channels and save a copy of your image for printing.    
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PSD (Photoshop) files won’t open (or print slowly) 

•	 Make sure to check the general question regarding File Names earlier in this document--nothing but letters, spac-
es, underlines, hyphens and periods should be in the file name

•	 In many cases, problems opening Photoshop files can be resolved by flattening the image in Photoshop prior to 
opening it in ImagePrint. While layers often are fine, there are some layers that can cause problems--this is espe-
cially true of “vector” type layers, like clipping paths or live text. 

	 Newer versions of Photoshop (CS, CS2 and CS3) have modified their file format, and sometimes need to be flat-
tened before being opened in ImagePrint even if the same file, saved with a previous Photoshop version, worked.

•	 Also, make sure that no extra (non-color) channels exist in the image.  To check for extra channels, open the file 
in Photoshop.  Choose CHANNELS under the Photoshop Windows menu.  In the Channels palette that appears, 
you should only see the standard  color channels (i.e., R,G,B for an RGB image).  Delete any extra channels and 
save a copy of your image for printing. 

•	 Try saving the file as a TIFF, or JPEG to avoid any issues with the Photoshop image format (which can sometimes 
have Photoshop specific information that doesn’t work well with non-Adobe applications)

Options button is grayed out in the Print dialog window 

When the options button is disabled in the ImagePrint Print dialog it is usually because certain library files were not 
updated during the installation of the software.  Typically this is due to permissions restrictions.

The library files can be manually downloaded from the ImagePrint web site and copied to the correct folder to correct 
the problem.  To download the library files,  go to the below download site by double-clicking the below link or pasting 
it into a web browser’s address bar::

 ftp://dfiles:dfiles@ftp.colorbytesoftware.com

You will be taken to the ColorByte general file download site. The file to download is called: 

 QT_update_libraries.dmg 

Download the file to your desktop.  

Next, open the FRAMEWORKS folder within the LIBRARY folder off your hard drive 

  / LIBRARY / FRAMEWORKS 

In that folder, delete the two files starting with QT:    “QTCore.frameworks”  and  “QTGui.frameworks” if they appear 
and empty the trash. 

Now, leaving the / LIBRARY / FRAMESWORKS folder open,  double-click the “QT_update_libareis.dmg” file that you 
previously downloaded to your desktop.  

You’ll see a window containing the two files: “QTCore.frameworks”  and  “QTGui.frameworks”.  Drag those files to the 
/ Library / Frameworks folder.

When done, try re-launching ImagePrint to see if the Options button now is active.

If you have trouble accessing the download site or can not locate the file to download, contact ColorByte’s support 
department for further instructions.

ftp://dfiles:dfiles@ftp.colorbytesoftware.com
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The File Browser doesn’t work correctly 

Hidden Folder Pane: If the File Browser appears, but shows no files or folders, check that the right 
side of the browser window has not been expanded to fill the browser’s display area:  To do this, move 
your mouse to the right side of the browser window--if a “double-arrow” icon appears at the inner edge 
of the window, you should be able to click and drag the dividing line between the two “panes” of the win-
dow to the right, which should cause the folders to be visible again. 

Preferences File Problem: If the File Browser doesn’t appear when you choose File Browser from 
the ImagePrint View menu, or it displays with no folders or files listed, there may be a problem with 
the ImagePrnt preferences.  This can happen if you’ve had a system crash, or if the File Browser was 
accessing a drive that is no longer available.  Try deleting the preferences file .  

The preferences file is called: com.colorbytesoftware.imageprint 7.0 plist  and is in the folder:  

 / users / ”user name” / library / preferences. 

Profile/Driver Mismatch Error when choosing Printer/Paper profile 

This error will occur if the Printer/Paper profile you have chosen in the Color Management window is not 
compatible with the version of the ImagePrint driver you are using.  ColorByte generated printer profiles are 
“tagged” with the driver version they were made for, and the software will pop-up this warning when a mis-
match occurs.  

Usually, profiles generated by ColorByte will have the version letter they were made for in the title of the 
profile (currently, it will be either a “b” or a “c”).  To check the version of the ImagePrint driver you are using, 
choose PRINT in ImagePrint, then choose SETUP.  The version letter will be listed in the Setup window.  
Versions may be backward compatible (i.e., the version “c” ImagePrint driver may work fine with version “b” 
profiles).  If you receive no warning when choosing your profile in the Color Management window, then you 
should be fine even if your driver version is of a later version than the profile.

To correct the problem if it occurs, either choose a different printer/paper profile, or update your copy of 
ImagePrint.  For details on updating ImagePrint, see this section: How do I update my software?
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Display Issues
If images aren’t displaying on screen properly within ImagePrint, look here for solutions

Images appear split, reversed or in triplicate on screen 

This condition can occur if you do not have a proper source profile chosen in the Input section of the Color 
Management window.  It’s most often seen with Grayscale printing.  Make sure to have a valid gray profile 
selected in the Missing Profile section’s Grayscale field (either “Gray gamma 1.8” or, most typically, “Gray 
gamma 2.2”).  Also, you should make sure the Embedded Action field is set to APPLY if using embedded 
profiles in your images.  Without a source profile chosen, the software will have no way of determining 
how to map the single channel grey data to the 3 color screen display, and distortion will result.

In the Output section of the Color Management window, make sure you have a valid Printer/Paper profile 
chosen for the media you are printing on.  Also, the “Press match” profile should be set to NONE unless you 
are specifically trying to cause your output to match to a press (in which case the press profile can be used 
there).  

In the vast majority of printing workflows, the Press Match profile should always be NONE.

Images appear scrambled, low resolution, or full of artifacts

•	 Extra channels in the image may cause it to display incorrectly.  To check this, open your image in 
Photoshop and check in the CHANNELS window that only the normal Color channels appear (no masking 
layers or other non-color channels should be in the image).

•	 Some layers may cause problems.  Try saving a flattened version of the file from Photoshop.

•	 If no extra channels appear, and it is flattened, and it is a tiff file , try re-saving the image from Photoshop, 
and in the Save... dialog box, make sure the “Pixel Order” is “interleaved” (not per channel) and that NO 
compression is being used.

•	 If the display appears low res, check in the ImagePrint Preferences window (available under the View 
menu) that Use Thumbnails is not selected. 

•	 Remember, to get a higher resolution preview of the image, you can click on the image while holding the 
Control key (or right click the image if your mouse has a right button) and choose High Resolution from the 
menu that appears. 

Some areas of images display cyan as if the image is being Gamut Clipped

This condition can occur if your monitor profile is a LUTS type.  ImagePrint only supports Matrix Monitor pro-
files.  
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Colorized B/W Images appear gray on screen 

This is normal behavior.  On screen, the colorized image will display using only the GRAY profile, but when 
printed, the colored portions of the image will use the selected COLORIZED B/W profile.

Colorized B/W Images appear distorted

This is usually the result of the image being 16 bit, or containing an Alpha channel.  Only 8 bit RGB images, 
with no alpha channels, are supported with this feature.

Two monitor system and ImagePrint’s colors are not displaying correctly

If you are using a two monitor system, it is important to understand that ImagePrint will only recognize the 
monitor profile for your System monitor.  Therefore, if ImagePrint’s display is residing on a secondary display, 
the monitor profile may be incorrect.  It may be necessary to designate the secondary monitor profile as the 
System monitor profile to have ImagePrint show colors properly on the second monitor.
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Printing Issues
Problems and questions related to printing and printing errors are listed in this section

Nothing Prints! 

There could be many reasons for your jobs not to make it to the printer.  While other sections of this troubleshooting 
guide lists more specific error conditions, here are the general things to check when you are unsure of the problem:

DEMO MODE:  Demo mode printing occurs when ImagePrint is running in “DEMO” mode due to a licensing issue 
such as the dongle not being available or the proper printer encryption not being in place--You will get no output 
from the printer if a license issue is detected and you are set to EMULATION mode in Spoolface.  Check the status 
area on the right side of the spoolface window to see if an encryption/licensing issue is reported..

IMPORTANT: If using the LITE version of ImagePrint (available for 13 inch wide printers only) you will get DEMO 
or no output if using any of the non-LITE features. Those features include: Templates, Color Correction tools, 
Backgrounds and Frames.  Multiple images on a boundary area will also cause demo with the LITE version.  

•	 Check the Status: In no printing is occurring after clicking PRINT, make sure to check the status in SpoolFace, 
the interface to the ImagePrint Spooler. (To launch spoolface, click the Spoolface icon at the bottom of the 
ImagePrint floating toolbar). In SpoolFace, make sure that the Computers menu shows the computer that is con-
nected to the printer selected, and the Printer menu shows the correct printer.  Check for pertinent errors within 
Spoolface that may shed light on the problem.  The bottom left corner of the SpoolFace window will show the 
current status of the printer (for example, Active-IDLE), and the scrollable area at the right side of SpoolFace will 
list job error messages.  Make sure to read through this section for information that might show the cause of the 
printing problem.

•	 Numeric Codes:  Most SpoolFace error conditions when printing will cause a numeric error code to appear in 
the bottom right section of the SpoolFace window.  (Typically, the format of this error message is: Printer dis-
abled with error XXX).  For a list of common numeric error codes that may appear in SpoolFace, see the section 
later in this guide: Spoolface Error Codes ·

•	 Nothing appears in Spoolface: This can happen if IP Setup was used to install an ImagePrint printer while 
SpoolFace and/or ImagePrint were running in the background.  This will often cause things to seem fine, but, 
when PRINT is clicked, jobs won’t go to the spooler with no error message generated.  The solution is simply to 
close SpoolFace and ImagePrint, relaunch IP Setup (from the ImagePrint folder) and remove, then reinstall, the 
printer(s).

•	 Un-pause the Queue: Make sure that the Queue menu at the top of the SpoolFace window is not set to 
Paused.  The spooler will pause if it encounters an error (such as running out of ink or paper) and it is important 
that you unpause the spooler after correcting the problem, or nothing new will be sent to the printer.

•	 Old Jobs in the way: Remember that the topmost job on the left side of SpoolFace is the next to print.  If 
that job has a problem that disables the spooler, until the job is moved to the “done” side (by dragging it to the 
lower, “finished” pane), no other jobs will be able to print--you’ll just be trying to print the original (top) one over 
and over.  

•	 Roll vs Sheet: Make sure that ImagePrint is set to SHEET mode if you are printing to sheet (not roll) paper, and 
vice-a-versa.  The sheet setting is in the row of icons located in the bottom right corner of the Main ImagePrint 
window--hover your mouse over the icons to see each icon’s function.  If some smaller printers, if the sheet/roll 
setting is incorrect for the type of paper currently loaded, the printer will flash its red paper light and never print, 
on printers with front LCD panels, a “Load roll/sheet” error will occur.

Continued on next page
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•	 Wrong connection specified in IP Setup:  A major cause of printing problems is an incorrect Printer con-
nection (i.e., USB, firewire, Ethernet) having been specified in IP Setup when ImagePrint was originally 
installed.  If you suspect this is a problem, reinstall the printer following the basic setup instructions earlier in 
this guide in the entry entitled: Reinstalling your ImagePrint Driver         

•	 Print to File: Make sure the Print to File option is not selected in the ImagePrint print dialog or no output will 
be printed (only a tiff file containing the layout will be saved).

•	 ImagePrint settings issues: Many printing problems are the result of an incorrect setting within ImagePrint 
(usually relating to Color Management or page size.  For example, Error 768 is a common error code that 
often indicates a color management issue).  Make sure you have correctly specified your Color Management 
settings within ImagePrint’s Color Management window.  (After making any changes, remember to drag old 
jobs from the top side of SpoolFace, and to un-pause SpoolFace from the Queue menu before attempting 
another print).  For information on proper color settings, please see chapter 6 of the ImagePrint PDF manual.

 •	 NETWORKED PRINTER PROBLEMS:  If your printer is connected via Ethernet, the usual reason for print 
failure is an incorrect IP Address specification for the printer in ImagePrint’s settings.  If the printer’s IP 
Address has changed since installing ImagePrint, ImagePrint will no longer be able to find the printer until it 
is changed back or ImagePrint is updated (via IP Setup) to reflect the new IP address.  For information on 
accessing and changing the printer’s IP Address, check the entry in this guide entitled: Networked Printer 
Settings.

	 Once you know the current IP Address of the printer, double-check that the same IP Address was used in IP 
Setup (launch IP Setup, and check the IP Address shown in the right side of the window for the printer (it will 
have /9100 after it).   If it is not correct, reinstall the printer using the instructions at the beginning of this guide 
entitled: Reinstalling your ImagePrint Driver.

 

Nothing appears in SpoolFace when Print is selected 

By far, the most common cause of this error is having run IP Setup to install an ImagePrint printer while 
SpoolFace or ImagePrint, were running in the background.  This will often cause things to seem fine, but, 
when PRINT is clicked, jobs don’t go to the spooler with no error message generated.  The solution is to close 
SpoolFace (and ImagePrint), relaunch IP Setup (from the ImagePrint folder) and remove, then reinstall, the 
printer(s).

Also, be sure that in SpoolFace you have the right printer and computer selected in the Printer and Computers 
menu at the top of the screen.  Only the jobs for the selected computer and printer will show in the SpoolFace 
window.

Printer outputs garbage text  

This condition occurs when bad data or partial data is sent to the printer, causing the printer to go into “text” 
mode.  Since turning off the printer can still leave stray data in the buffer of the computer, and turning off the 
computer can still leave stray data in the printer buffer, it is advised that to correct this condition you power down 
both the printer and the computer to ensure that neither device retains any partial data in its buffer.  (Make sure 
to disable the ImagePrint queue before powering down the computer by choosing DISABLE from the QUEUE 
menu in SpoolFace).  Then, turn the computer and printer back on.  Un-pause Spoolface from it’s Queue men 
and try sending a new job to the printer.  
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“Load ROLL” (or Sheet) Paper message on printer 

This message appearing on the printer means that ImagePrint set to a paper type (sheet or roll) that is not currently 
loaded in the printer.  To change ImagePrint’s Sheet/Roll setting, click the sheet/roll icon in the bottom right hand corner 
of ImagePrint Main Layout window.  (The Sheet/Roll icon is the 2nd from the left in the row of icons--hover your mouse 
over them to see their function).

 Likewise, make sure the printer’s control panel (on the front of the printer) is set to the right mode for the currently 
loaded paper type.  (Often, pressing the Roll/Sheet button on the printer when this error occurs will let the job continue).

“Forbidden Media” message on printer 

This message, on the front console of the printer occurs when the printer rejects paper as  illegal to load in the paper 
tray.  Only certain papers are certified to work with the printer tray.  If you wish to have the printer use the loaded paper 
anyway, choose another paper in the “Media Type” menu (within the Options window of the Print Dialog).  Media Type 
settings control the paper feed controls of the printer--pick one as close as possible to the thickness of the paper in the 
paper tray to avoid banding issues.

“Reload Paper”/”Paper Out” message on printer

“Reload Paper messages often mean the paper loaded in the printer is NARROWER than the page size specified in 
ImagePrint.  You can correct this by specifying a smaller page size in ImagePrint, or, by disabling the “Check Sheet 
Size” option in the Printer’s front control panel. In some cases, manufacturers ship paper that is incorrectly sized, so 
make sure to measure your paper to ensure it is the size stated on its packaging--even small differences in size can 
cause this error to occur.

“Paper Out” messages, or the paper feeding through the printer without printing, typically occurs if the paper in the 
printer is SHORTER than the page size specified in ImagePrint.  To correct, specify a page size in ImagePrint that is 
the same as the physical paper’s length or shorter.  (Double check by measuring the actual paper--some manufacturers 
can be slightly inaccurate in the dimensions specified on the box).

Another cause of paper feeding right through the printer without printing is a paper sensor issue.  Make sure to use a 
clean sheet of paper, as the printer’s sensors check for paper white and can be fooled by previously printed images on 
a page.
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“Wrong Page Size” message on printer  

If the message “Wrong Page Size” appears on an Epson printer when attempting to print, it is due to the printer 
sensing a different page size than that being specified by ImagePrint.  Printers can be very sensitive to slight differ-
ences in page size, especially when loading thicker paper types.  In some cases, manufacturers ship paper that is 
incorrectly sized, so make sure to measure your paper to ensure it is the size stated on its packaging--even small 
differences in size can cause this error to occur.

One way to avoid that error is to turn off the “Page Size Checking” feature of the printer.  This will cause the printer 
to no longer check the page size when printing.  To turn page size checking off, on the Epson’s front control panel, 
use the Menu button to enter the Printer Setup section.  Use the up and down keys to find the “Page Size Chk” 
entry.  Hit the right arrow button to access that setting, then use the UP arrow to toggle to OFF and hit the Enter 
key.  An asterisk will appear next to the word OFF showing it is now in effect.  Then use the right arrow button 
repeatedly to get back to “Ready”.  NOTE: Turning off he “Page Size Chk” setting may cause prints to not be cen-
tered correctly when sheet paper is loaded manually on the printer.    (Often, pressing the Roll/Sheet button on the 
printer when this error occurs will let the job continue)

SpoolFace generates an error when launched  

With SpoolFace active, make sure to choose the computer host from the Host menu at the top of he screen, and 
the printer from the Printer menu at the top of the screen.  (Occasionally, after installation the host and printer 
names will have no selection associated with them, and this can cause an error condition.)

You may also see a “No Printers available” message is your are on an ImagePrint CLIENT computer.  This is nor-
mal behavior, as the spooler is trying to find a printer on the local machine.  Just choose COMPUTERS (from the 
SpoolFace menu at the top of the Macintosh screen), and pick the IP Address of the ImagePrint HOST computer.

If there is no PRINTER or COMPUTERS menu at the top of the screen when SpoolFace is active, there is a prob-
lem with the installation.  Close SpoolFace and ImagePrint, then re-launch IP Setup (from the ImagePrint folder), 
remove and reinstall the printer(s). 

Epson 2200 or 2400 doesn’t print, red paper feed light shows  

This is typically caused when ImagePrint is set to the wrong paper mode (sheet vs roll).  The 2200 and 2400 are 
picky about this setting, and if ImagePrint is set to the wrong one for the type of media loaded in the printer, the 
result is no output, and a red light on the printer. Make sure the Roll/Sheet icon, in the bottom right corner of the 
main ImagePrint window, is set correctly to Sheet. (Hover your mouse over those icons to see their function list to 
the left)
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I keep getting extra jobs sent to spoolface  

This is the result of additional pages existing in the ImagePrint layout window. This can happen if AutoFlow 
is enabled and you have added images to your layout without first deleting previous images via the scissors 
tool--new pages are generated for new images when there is no room on the current page. With autoflow 
turned ON, choosing PRINT will cause all pages to be sent to the spooler by default.  

Autoflow can be turned on and off via the AutoFlow icon, located in the row of icons in the bottom right corner 
of the main ImagePrint window (hover your mouse over the icons to see their function and current setting).

The Page Control setting, also at the bottom of the main ImagePrint window, will always show the page you 
are on (for example, if on page 2, it may say “Page 2 of 2”).  To delete an unwanted page from the Imageprint 
layout, move to that page via the left or right arrow icons within the Page Control and click the Red scissors 
icon in the Floating toolbar.

Printer flashes lights, or generates Command Error when attempting to print  

This error is caused when ImagePrint is set to an inkset other than that currently in use by your printer.  This 
can happen if you have selected the wrong Printer/Paper profile in the ImagePrint Color Management window.  

The Printer/Paper profile is responsible for determining the ink set used in the job--picking a profile made for 
an ink set not currently installed on the printer will cause this error occur.  

Remember, for most Epson printers:

When printing with MATTE black ink, the profile should have “mk” in the title.  

When printing with PHOTO black ink loaded in the printer, the profile will have “pk” in the title.  

When using our special PHATTE black configuration, the profile should have “dk” in the title.

“Can’t print scanlines” error, jobs go into the spooler but never print

This is usually an issue with the connection to the printer. Confirm that you designated the correct port for 
your printer during the installation (you can double check this setting by launching the IP Setup utility and 
seeing what is listed in the Installed Printers area for your printer.  The device selection will show up within 
the parenthesis in the printer line (i.e., (epusb) means USB and (ep1394) means firewire).  If you suspect the 
wrong connection was specified, try removing and reinstalling the printer according to the Re-installing your 
printer entry earlier in this guide.
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“Couldn’t Spawn Queue Command” error when clicking print 

Host/Client printing: This error can also occur when printing from an ImagePrint CLIENT to an ImagePrint 
HOST computer if the two computers can not see each via the TCP/IP network protocol.   Firewalls or anti-
virus software may also prevent the Client from communicating with the Host.  You should also check via the 
Windows Task Manager that the “muxd.exe” process is running on both the Host or Client (muxd is neces-
sary for client/host printing to take place).  Check the section: Problems printing from a networked client 
for information on troubleshooting problems in this area.

How do I print directly from an Application like Photoshop, InDesign or Illustrator? 

IMAGEPRINT allows you to print directly from virtually any other application, including Photoshop, InDesign 
with the optional PTA (Print Through Applications) feature. Application level printing is installed when you 
install either the Windows or Macintosh version of IMAGEPRINT but must be licensed to run in non-demo 
mode.

NOTE: It is recommended for troubleshooting purposes that before using application printing, you confirm that 
you can successfully print directly from the ImagePrint application first.  

Information on PTA is in the PTA chapter within the ImagePrint users manual, along with Troubleshooting 
information for common problems and limitations.
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Problems printing from a networked client  

A Client installation of Imageprint will run the normal ImagePrint interface, but, when Print is selected, will send all 
of its jobs to the ImagePrint HOST computer (the Host is always the computer with the DONGLE attached).  When 
installing a client, remember that the Client does not need to be licensed in IP Setup (even if it shows “disabled” in 
the Installed Printers side of the IP Setup window).  All licensing is handled by the HOST at print time, so only it 
needs to be licensed.  

Below are things to check if you experiencing problems printing from a client to a host:

1.	 Make sure that the Host computer can print directly to the printer first to rule out a problem with the printing 
in general. 

2.	 Make sure that the Client computer can “see” the Host across the network by “pinging” it via an OSX 
Terminal window. 

   To “ping” the remote computer from a terminal window on OSX:

•	 Open the terminal by double-clicking the terminal application from the /Applications/Utilities folder on     	     
your system

•	 In the terminal window, type in the following command and hit return:

	         ping “xxx.xxx.xxx.xxx”     

	 (Where xxx.xxx.xxx.xxx” is the ip address of the remote computer.)

•	 Check the messages that appear after typing the ping command to see if the 	 	 	 	 	
remote computer can be reached from the host.  Error messages indicate a net					   
work problem that needs to be addressed before ImagePrint can utilize network 	 	 	 	 	
printing.

3.	 Firewall settings, on either the Host and Client, can block ImagePrint from sending jobs.  Try printing from 
the Client with the Mac Firewall disabled.  (The Macintosh firewall is usually accessed from the Sharing 
Panel in System Preferences)

4	 If the Host computer can print, but jobs from the Client do not appear in the Host’s SpoolFace window, 
make sure that you specified the name IP Address of the HOST when installing ImagePrint on the Client.  
This entry should go in the PRINTER HOST field--make sure you did not put it in the wrong place.  To dou-
ble-check, launch IP SETUP and see what setting is listed on the Right side of the IP Setup window for the 
printer after the @ symbol.  It should be the ip address of the Host computer.  If incorrect, REMOVE the 
printer using the REMOVE button in IP Setup, choose the printer type again, choose CLIENT as the instal-
lation type, enter the IP Address of the remote computer and click INSTALL.  Important: Make sure that 
ImagePrint, and SpoolFace, are NOT running when you perform this reinstall.

5.	 If the jobs are making it to the HOST’s Spoolface window, but erroring out (typically with a long string 
of numbers starting with “107…” ) it is usually because a profile is being selected on the CLIENT side 
that is not available on the HOST side.  Make sure that any profiles you are using are available in 
ImagePrint’s COLOR folder of both systems.  Also, be careful that none of the profile names exceed 31 
characters in length or you may also get this error.

6.	 If you are receiving a message along the lines of “Can’t write file”, or ERROR 97, you may have a permis-
sions issue.  When CLIENT jobs are sent to the spooler, all images within the job are written as tempo-
rary files to the HOST computer, in the .../imageprint/spool/”printer name”/IMG folder.  If that folder is not 
accessible, you may get this error.  Make sure that the IMG folder exists, and has full write permissions. 
Performing the procedure listed in the entry: Opening Permissions on the ImagePrint folder on the 
HOST computer may correct the problem.  Also, make sure you have ample hard disk space on the HOST 
computer.

7.  	 If printing to a Windows computer, the process “muxd.exe” must be running on the Windows Host in order 
for communication to take place.  You can confirm that this process is running on the Windows HOST via 
the Windows Task Manager (hit Control-Alt-Delete to access it).  If muxd.exe is NOT running it can be 
manually started from it’s location in the /Program Files/ImagePrint/ SPOOL/MUX folder. (This process is 
set to start automatically when ImagePrint is installed on Windows).
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Job doesn’t move to finished side of spoolface when cancelled 

Normally, dragging a job from the top (“active”) pane to the lower (“finished”) pane should stop the job from printing.  
If the job will not move over, it means that the printing process is not being allowed to quit normally by the Operating 
System.  To force the job over, do one of the following:

1.       The cleanest way to handle this condition is to PAUSE the queue by choosing Queue->Pause from the 
Spoolface menu, then reboot the computer.  The job should drag over with no problem when the system 
comes back up.  (It is important to pause the queue first, to make sure the spooler doesn’t attempt to print 
again as soon as the system reboots.)    After rebooting and moving the job over, remember to un-pause  
the queue by choosing “Pause” from the same menu and ensuring the check mark beside “Paused” is no 
longer there. This method is the cleanest, as it will reset the computer ports.  

	 Although the following method will also work to clear the job from spoolface, if the computer ports are 
“hung”, you may still have trouble printing until you reboot.

2.       Access the Macintosh Activity Monitor from the /Applications/Utilities folder on your system.  Look for the 
process named after the printer (ie, Epson4800) and choose to end it.  The job will immediately move over 
in SpoolFace. 

Old computer names appear in my SpoolFace COMPUTERS menu

To remove any old computer names from the Spoolface COMPUTERS menu, close spoolface and locate the file “ip 
hosts” located in the Spool folder within the ImagePrint folder.  Edit the “ip_hosts” file using a standard text editor such 
as Text Edit and delete any lines containing unwanted printers and resave the file, then relaunch Spoolface.
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Spoolface error codes 
When there is a problem printing, Spoolface usually shows a numeric error code that can be referenced in this 
section

ERROR 1 

This error typically means a software corruption of some type and may require removing and reinstalling the soft-
ware.  

It can also occur if an illegal character (such as a space) was used in the PRINTER NAME when installing via 
IP Setup, or if anti-virus software is running on your computer that is interfering with ImagePrint’s printing pro-
cesses.

If you do have anti-virus software, try disabling it and see if the problem persists.

If there are spaces or non-alphanumeric characters  printer name you used when installing via IP Setup, remove 
and reinstall the printer via the instructions earlier in this guide: Reinstalling your Imageprint Driver - A Basic 
Walkthrough  making sure not to use spaces in the printer name.

If removing and reinstalling the driver via IP Setup fails to solve the problem, try removing ImagePrint completely 
and reinstalling according to the instructions in the ImagePrint Users guide.

ERROR 2 or ERROR 15 

This indicates a problem communicating with the printer.  Make sure the printer is on and online. Make sure that 
you specified the correct connection setting when installing ImagePrint (you can double-check this by launching 
IP Setup and seeing what is listed in the Installed Printer’s area for your printer.  The device selection will show 
up within the parenthesis in the printer line on the RIGHT side of the window--it will either be the port the printer 
is connected to (i.e. USB001) or the name of the Windows Printer driver you chose when installing (ImagePrint 
will use whatever port that driver is using when installed in this way).  If in doubt, try removing, then reinstall-
ing printer using the instructions in the entry at the beginning of this guide: Reinstalling your Imageprint 
Driver - A Basic Walkthrough

If you’re sure the connection was specified correctly and you still get the error, you may have a device driver 
problem.  Try printing from the printer manufacturer’s driver via the Test Page option within the Printers and 
Faxes driver for that printer.  If that also fails, switch connection cables to ensure there is no problem there, and 
make sure to reboot both the printer, and the computer to reset both interfaces.

Continued on next page



T40 IMAGEPRINT 	 	 	                            Troubleshooting

ImagePrint Macintosh Troubleshooting Guide (Cont.) Back to Table of 
Contents

Back to Table of 
Contents

ERROR 97 

This is a file access problem—the spooler is not able to access the file to be printed.  

Make sure the file(s) to be printed is still accessible.  Deleting a file or moving it from its folder after clicking PRINT in 
ImagePrint before the image has actually printed can cause this condition as the Spooler will not be able to access the 
file.  Having your files on a cd, and ejecting the cd before the printing takes place, will cause this as well.  All the images 
on the page must remain in their original location while the page is printing. 

If your images exist across the network, try moving it to a local directory and reprinting to confirm a network access 
issue is not the cause.  

ERROR 128

This usually means that ImagePrint was installed over a previous version of the software.  It’s important that when 
installing ImagePrint that you remove any previous versions of ImagePrint prior to the new install.  To correct the prob-
lem, it will be necessary to remove the ImagePrint folder, then reinstall from scratch.

ERROR 163 

This usually indicates some kind of connectivity problem with the printer. Make sure that the way you are connected to 
the printer corresponds to the connection type specified in IP Setup.  Try removing the printer via IP Setup, and rein-
stalling (follow the Re-installing the printer instructions earlier in this Trouble Shooting guide.).  Be sure, if using USB or 
Firewire, to click the “...” button in IP Setup, and use the “Windows Printer Name” as the connection type, as described 
in the installation section of the ImagePrint manual.

ERROR 513

This indicates a problem communicating with the printer.  Make sure that you specified the correct connection setting 
when installing ImagePrint (You can double-check this by launching IP Setup and seeing what is listed in the Installed 
Printers area for your printer.  The device selection will show up within the parenthesis in the printer line (ie, (epusb) 
means USB, (ep1394) means Firewire)) on the RIGHT side of the window.

Most often 513 occurs with Firewire connections to an Epson printer.  Firewire is not recommended for Epson printers 
on the Mac due to problems with the Epson provided drivers used by this operating system.  USB or ethernet are more 
reliable and just as fast.  If firewire is the only option, you may need to update to newer firewire drivers.  Check the 
ColorByte general download site at:  	 ftp://dfiles:dfiles@ftp.colorbytesoftware.com

for a disk image (dmg) file containing the latest firewire drivers.  Download and mount the disk image and read the read-
me file contained within for instructions on updating your system with those drivers.  If that fails to work, you may not be 
able to reliably connect to your printer via Firewire.  

Although it may work on some systems, ColorByte does not support Firewire for Epson printers on Leopard (OSX) 
and later Macintosh operating systems.

ftp://dfiles:dfiles@ftp.colorbytesoftware.com 
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ERROR 527

This indicates a problem communicating with the printer.  Make sure that you specified the correct connec-
tion setting when installing ImagePrint.  You can double-check your settings by launching IP Setup and see-
ing what is listed in the Installed Printers area for your printer on the RIGHT side of the window (do not pay 
attention to the Printers to Install section on the left)  

The device selection will show up within the parenthesis in the printer line (epusb) means USB, (ep1394) 
means Firewire, an IP Address followed by 9100 means an ethernet connection).

IMPORTANT: If you have previously gotten another error message (such as Error 768) prior to getting the 527 
error in SpoolFace, the ImagePrint print drivers may be “hung” due to the first error.  This condition can cause 
the 527 error to occur for every subsequent print until the system has been rebooted.  To be sure the 527 error 
is not a “red herring” caused by a previous error condition, reboot the computer (and turn the printer on and off )

and try printing again to confirm the 527 error occurs in SpoolFace on a “clean” system.

After confirming the 527 error occurs even after rebooting, check the following for suggestions on resolving 
this error for your printer connection type:

USB: Make sure your cable is 12 feet long or less to avoid connectivity problems.  Other USB 
devices may cause interference--try removing any non-essential USB devices from the USB bus.  
Simultaneously printing to multiple USB printers may cause some computers to have connectivity 
problems---try putting some printers on Ethernet, or on a 2nd USB card, to avoid USB throughput 
issues.

Ethernet: It is important the printer is reachable via the IP Address you specified in IP Setup when 
installing the printer.  Consult the section of this guide entitled: Networked Printer Settings for infor-
mation on troubleshooting Ethernet connectivity issues.

Firewire: If connected via Firewire to an Epson printer, it is necessary to have installed the Epson 
firewire drivers in order for Imageprint to communicate with the printer.  Please see the previous entry 
(Error 513) for information on Firewire issues)

ERROR 609 

This error is memory related.  It usually is caused by one of the following:

* 	 The image being printed no longer is accessible.  This can occur if you’ve deleted or moved the actual 
images within a job before it begins to print, or, if images located across the network are no longer 
accessible across the network at print time.

* 	 There is an alpha channel in the image file you are printing.  (Alpha channels are not supported 
by ImagePrint.)  To check for extra channels, open the image in Photoshop, and choose Windows-
>Channels.  In the channels window, make sure only the standard color channels are listed (i.e., R,G,B).
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ERROR 611 or 104 or 99 or  “Out of Disk Space error” 

Over 2 gig temp file:  This error may occur if the dimensions of the print you are making causes a temporary 
file to be made that exceeds the ImagePrint 2 gigabyte limitation.  

You may also see an error in Spoolface that indicates there is not enough disk space to process the image 
when you know there is plenty--this incorrectly reported error condition can be caused by the temporary file 
exceeding the 2 gig limit. 

If you are printing a very large, banner type of image and are seeing this error, try setting the Resolution set-
ting (located in the ImagePrint Print dialog box) to 180 rather than the default 360. This will reduce the total 
amount of data sent to the computer, with a slight reduction in quality (This very slight loss in resolution is not 
visible from more than a few inches away, which is typically fine for banners and large posters.)   

You may also be able to avoid this error by preventing ImagePrint from needing to build a temporary image at 
all.  Most jobs do not require a temp file be created,  If possible, don’t rotate the image in ImagePrint (rotate 
it first in Photoshop), and avoid the use the Step and Repeat feature when making extremely large prints.  
Rotated images will always generate a temporary file, as will Step and Repeated images and any prints that 
use the Tiling Across Pages feature.

Out of disk space  Another cause of the problem may be that you are running out of disk space to process 
the images.  Large temporary files may be created if images on the page have been rotated 90 degrees, or 
you are using the step and repeat function.  If you encounter this error, increase your disk space by deleting 
unnecessary files.  Rotating the images first, before bringing them into ImagePrint, can also prevent the need 
for the temp file to be built.  

Changing the temporary file location

Changing the location where ImagePrint stores its temporary files to a hard drive with more space is one solu-
tion to storage problems. To change the directory in which ImagePrint writes temp files (needed when images 
are rotated 90 or 270 degrees), edit the file “ipbatch.bat”, located in the  ...printers\”printer_name” directory off 
of the ImagePrint software directory, and add the line: “PRINT_TMP=directory” entry to the end of the file to 
reflect the new directory.  (For example, set the PRINT_TMP=d:\temp)

Note that any new temporary file location should be on a local drive, not one located across the net-
work!

ERROR 616 

- Try using the red scissors to delete everything on the page, then open the image again and try another print.

- If the problem persists after doing the above, there may be a problem with a layer in the file.  Open the 
image(s) in Photoshop and flatten them.  Alsok in Photoshop’s CHANNELS window, make sure there are no 
extra channels (such as masking channels).

ERROR 653

A wrong setting in the print job being sent from ImagePrint most likely causes this error.  Check that the 
selected INKSET is correct for what is loaded in your printer.  Make sure that you have made valid Profile 
selections in the Color Management window of Imageprint.
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ERROR 768 

This error can have a few causes:

 -  Not having selected a Media Type in the Options menu of the Print Dialog may cause this on printers that 
support the Media Type field.  (The Media Type setting affects the paper feed settings on some printers).  You 
can check the Media Type setting by choosing PRINT within ImagePrint, then click the OPTIONS button to 
get to the Options window which will show the Media Type if your printer supports that feature (most Epsons, 
with the exception of the 2200, support the Media Type feature).

 -  In the Output Section of the Color Management window, a PRINTER profile should be selected that is correct 
for your printer and ink. (Note: if you wish to print grayscale images on an Ultrachrome printer, make sure to 
pick a printer profile with “Gray” in the title.)  Most users should leave the PRESS MATCH setting to “NONE” 
unless they are trying to match another device, like an Offset press.

 -  In the INPUT section of the Color Management window, make sure that an appropriate source profile for your 
images is selected for each color space your images use within the Missing Profile/Untagged Images sec-
tion (RGB, CMYK, Grayscale).  For printing single-channel grayscale images, make sure to pick either “gray 
gamma 1.8”, or “gray gamma 2.2”, in the Grayscale field.  If using embedded profiles, make sure to select 
either PROMPT or APPLY in the Embedded Action field. 

-	 An incorrect ink set setting can cause this error to occur as well.  Normally, when choosing a Printer profile 
the proper ink set will be automatically selected.  If using a profile that was not created by ColorByte, it will be 
necessary to manually choose the correct ink set prior to printing via the Setup window, accessed from the 
Print Dialog box.

-	 A sub-folder, within ImagePrint’s COLOR folder, can also cause error 768.  Make sure only color profiles are 
present in the COLOR folder, and that no sub-folder’s have been placed there.
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ERROR 107############   

A long (8 digit or more) error number (usually beginning with 107) happens when an error condition took place 
that ImagePrint wasn’t able to generate a proper error code for.  Usually this means that ImagePrint’s memory 
state was corrupted.  The usual reasons for this condition are:

- 	 An empty page has been sent to the spooler. This is often the result of additional pages inadvertantly 
existing in the layout window.  Check in ImagePrint that you are on the expected page.  That information 
is listed in the bottom of the ImagePrint window--for example “Page 2 of 2”.  Remember that if AutoFlow 
is turned on, each time you add an image to the layout window, it will generate a new page if the image 
can’t fit on the current page.  When you choose PRINT, all pages will be sent to the spooler if you don’t 
select a range of pages in the print dialog.  To turn off AutoFlow (causing images to stack on top of each 
other when they can’t fit on the page) click the Auto-flow icon in the bottom right corner of the Main 
ImagePrint window.  

		 To delete an unwanted page from the Imageprint layout, move to that page via the page controls in the 
bottom left hand corner of the ImagePrint window, and click the Red scissors icon in the Floating tool-
bar.

- 	 Another cause of this error is if one of the profiles you are using (usually the Printer/Paper profile) has 
a filename that is too long.  This is especially a problem on Macintosh computers.  Make sure that the 
full name of the profile (including the “.” and extension) is no more than 31 characters.  Unsupported 
non-alphanumeric characters, like “&”, or commas, in the profile or image filename, can also cause this 
problem.

- 	 If printing with templates, a corrupt template can cause this problem.  Try printing without a template 
applied to see if it corrects the problem. 

-	 Corrupt images, images with extra channels (as seen in Photoshop’s CHANNELS window), images 
saved with compression, or images saved with the Pixel Order set to “Per Channel” all may cause this 
error to be generated.

-	 Too many images on a page:  Although it can be highly dependent on RAM, processor and image 
type, its recommended that you limit the number of images to 40 or so per page to avoid overly taxing 
system resources.  If you need to print more than that, split them up between pages (you can use the 
AutoFlow function to have images automatically “flow” to a new page when the current one is full).  

- 	 CLIENT/HOST printing: If printing from an ImagePrint networked Client to a Host, make sure that any 
profiles you’ve selected on the Client computer are available on the Host computer (within ImagePrint’s 
COLOR folder) as well.  Otherwise, when the Host attempts to print the job, it won’t have access to the 
specified profile and will cause this error.
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Output Quality Issues
Look in this section if you are able to print, but you have questions regarding the quality of the output. 

My output is darker than it appears on screen

If colors are correct, but the overall print seems dark compared to the ImagePrint or Photoshop display, it is most 
likely caused by your LCD monitor being too bright.  

Many LCD monitors are factory calibrated overly bright in order to compensate for the typical LCD’s problems 
with rendering shadow detail.  Even if you have custom calibrated your monitor, it is very likely that it is brighter 
than the “standard” CRT monitor of the past. 

Simply physically dialing down the brightness of the monitor, using it’s on screen controls, is usually the solution 
to this issue.

Color cast in prints  

Nozzles: As with any color issue, make sure you have done a nozzle check on the printer, and that all nozzles 
are clean.  Nozzle issues are the chief cause of cast problems.

Profile temperature: The two most common color temperatures to use are EDAY (daylight) and ECWF2 or F3 
(mixed lighting).  We have seen many users using the EDAY profiles and viewing under fluorescent light--this will 
cause a magenta cast most noticeable in blues.  The F2 (ECWF2) and (if available) F3 profiles are more accu-
rate for viewing under mixed lighting conditions and most likely will remove the magenta cast you see with the 
daylight profiles.  

Color Management settings: Check your ImagePrint Color Management settings. 
	 In ImagePrint, choose Image -> Color Management:
			  In the Output section: 

- Make sure a correct printer/paper profile is selected for your paper.  

- Make sure NONE is set for the Press Match field.  

  In the Input section:

- Make sure Embedded Action is set to Apply

- Make sure that your normal Photoshop working spaces are selected in the Missing Profile 		
  section for each color type.  

Color Management workflow: Images that have been incorrectly color managed can show a cast when printed. 
For more information on this, please see the Consistent Color Management Tips section in this guide.
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Images are not centered on page 

In the following, orientation is always relative to the observer facing the front of the printer.  For example, 
Top refers to the leading edge of the paper as it comes out of the printer, Left refers to the left edge of the 
paper as it comes out of the printer.

•	 Top/bottom differences on sheet paper:  Most printers have different top and bottom margins when using 
sheet paper.  This fact can cause images to appear off center vertically when printed. (The Epson 2200, 
2400 and 3800 are exceptions to this and allow equal top/bottom borders on sheet, but all other Epson print-
ers have a 1/8th inch top  and 5/8ths bottom margin on sheet). 

	 To compensate for this limitation you can choose Center Margins from the row of icons in the bottom right 
corner of the main ImagePrint window (hover your mouse over these icons to see their functions listed on 
the right).  This will cause the size of the smaller top margin to increase to that of the larger bottom margin, 
reducing the total printable area while compensating for the difference in margins.  If you then choose to 
center your images, they should print with equal top and bottom borders.  Make sure to readjust any existing 
images on the page after changing this option, as the change in layout size will shift things.  And be aware 
of the smaller page size--with Centered Margins turned on, there is 4/8th of an inch less vertical print-
able area available on the page for most Epson printers.  The Centered Margins setting has no effect 
when set to ROLL paper.

 •	 Paper Feed: Another potential cause of Top/Bottom centering issues is an incorrect setting in the Media 
Feed section of the OPTIONS dialog (for printers that support it).  For thicker papers, select the closest 
match to your paper to ensure that paper is fed correctly.  Ultra Smooth Fine Art Sheet is typically the thick-
est option available. 

•	 Roll or sheet setting incorrect: Make sure you have made the right selection for roll or sheet in ImagePrint 
(via the Roll/Sheet icon in the bottom right corner of the main ImagePrint window) or centering issues may 
result.  Also, make sure that the correct TRAY option is selected in the ImagePrint Print dialog when printing 
on sheet paper.  (Typical tray options are:  ASF (Automatic Sheet Feeder), Manual, Front, or Back). 

•	 White border on images: Creating an image with a white border around it is a common cause of centering 
problems.  Remember, ImagePrint will treat the image in its entirety, and has no way of knowing that a white 
border is not part of the image.  It will therefore place the image beginning at the edge of the white bor-
der, which may cause unexpected positioning results.  It is usually recommended that images brought into 
ImagePrint not have any unnecessary white borders.

•	 Paper size: Make sure that the actual size of the page you are printing on matches the page size specified 
in ImagePrint.  Surprisingly, papers sometimes are shipped from the manufacturer with slight size differenc-
es.  These can result in non-centered printing.  Measure the paper to ensure it is the correct size if you see 
an unwanted border.  You can then use ImagePrint’s User Defined page size window to define a page size 
that exactly matches the physical dimensions of your paper. 

•	 Incorrect paper loading: How you load the paper in the printer can make a difference in the margins.  
Make sure that you are loading it according to the manufacturer’s instructions.   

•	 Printer margin set incorrectly:  Many printers allow you to set the margin for roll paper on their front con-
trol panel.  ImagePrint assumes this margin is at the lowest setting (typically 3 mm).  Make sure that your 
printer is  currently set to the lowest roll margin setting or incorrect margins will result.  (Typically, the Roll 
Margins setting is accessed within the Printer Settings menu of the printer.  On Epson printers, the value with 
the asterisk is the one in use--consult your printer manual for details on setting the roll margins for your spe-
cific printer).
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I’m getting an unwanted margin on my prints 

In the following, orientation is always relative to the observer facing the front of the printer.  For example, 
Top refers to the leading edge of the paper as it comes out of the printer, Left refers to the left edge of the 
paper as it comes out of the printer.

Borderless not set: If you want to print without any margin at all, make sure that borderless mode is 
enabled via the borderless icon in the bottom right corner of the main ImagePrint window.  Remember--
most printers only allow full borderless printing on roll paper, not sheet.  Also, only certain paper widths will 
print with no borders.  Check the Printer Specific section of the appendix of the ImagePrint User’s guide for 
information on the borderless capabilities of your printer.  Remember, if you see a pink border surrounding 
the layout area within ImagePrint then full borderless is not in effect.  Full borderless mode will show no 
pink border.

1/8th inch margin on left or right side: A border on the left or right side when attempting to print in 
borderless mode is usually an indication that the image is incorrectly positioned on the page.  This can 
happen if you switched to borderless mode after you have positioned your image on the page.  In that 
scenario, the layout area will have changed but the image will still be positioned at the edge of the origi-
nal (bordered) area.  Always reposition (or remove and reopen) your images after making changes to the 
borderless setting.

1 to 2 mm “hairline”: Most inkjet printers can vary as much as 2 millimeters in the way they position the 
edge of the paper.  This can cause a thin line to appear on the edge of your full bleed prints. The “Global 
Printer Compensation” controls, available in the Preferences window of ImagePrint (found under the View 
menu) can correct for this hardware variability.  Setting a positive (right) or negative (left) X value will move 
the entire layout at print time and allow you to correct for these “hairline” issues.

Printer margin set incorrectly:  Many printers allow you to set the margin for roll paper on their front con-
trol panel.  ImagePrint assumes this margin is at the lowest setting (typically 3 mm).  Make sure that your 
printer is  currently set to the lowest roll margin setting or incorrect margins will result.  (Typically, the Roll 
Margins setting is accessed within the Printer Settings menu of the printer.  On Epson printers, the value 
with the asterisk is the one in use--consult your printer manual for details on setting the roll margins for 
your specific printer).

I’m getting a wasted strip of paper between each print

This usually means you are not set to the correct cut mode for your printer.  Check in the Options window 
(accessed by clicking OPTIONS in the ImagePrint Print dialog box) that you are set to “Single” as the cut 
mode (for printers that support that option) to ensure your borderless prints are cut without a strip of paper 
between prints. Look in the ImagePrint manual’s Printing chapter for more information on Cut Modes. 
(Some older printers, such as the Epson 4000, 7600 and 9600, are not supported for single-cut mode and 
will always have some wasted paper when printing in borderless mode).



T48 IMAGEPRINT 	 	 	                            Troubleshooting

ImagePrint Macintosh Troubleshooting Guide (Cont.) Back to Table of 
Contents

Back to Table of 
Contents

My print is too long or too short 

Print-length issues are typically due to problems with the printer’s paper feeding controls. There are only 
two controls that ImagePrint has for paper feed:

Media Type: The Media Type menu within the Print-> Options dialog (for printers that support it) 
allows you to choose a pre-set within the printer for different media types.  For thicker papers, select 
the closest match to your paper to ensure that paper is fed correctly.  (Ultra Smooth Fine Art Sheet is 
typically the thickest option available.)  

Media Feed Adjustment: If available, increasing the Media Feed Adjustment setting (also in the 
OPTIONS dialog) can have the effect of lengthening the print by increasing the distance between 
printer passes.  This slider rarely needs to be adjusted, but for very long prints on heavy papers (like 
canvas) it can help to compensate for problems with the printer’s paper feeding.

The last few lines of my prints fade or don’t print 

Wrong paper size (length): This condition can be caused by an incorrect page size setting.  If the page 
size you have selected within ImagePrint is larger than the page loaded in the printer, the page may eject 
before the last bit of the image is printed.  Measure the physical page to make sure it came from the manu-
facturer at the correct length--papers are often slightly smaller than the specified size (in which case you 
can specify a smaller page size in ImagePrint’s User Defined page size dialog box).

Epson Driver interference: This can be caused by interference from the Windows Epson Stylus driver.  
To correct the problem, get properties on the Stylus driver (found in the Windows Printer Control Panel--
make sure to  pick the printer with STYLUS in the name--NOT the ImagePrint installed driver) and, in its 
PORTS tab, disable “Bidirectional Communication”.  Note this will cause the Epson Status Monitor to not 
be able to see the printer.  You will need to turn this setting back on to use that utility, then off again to use 
ImagePrint.
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Jobs print distorted or as negatives

Color Management settings: Something very wrong in your ImagePrint Color Management window could cause 
files to print distorted.  Check the following: 
	 In ImagePrint, choose Image -> Color Management:
			  In the Output section: 

- Make sure a correct printer/paper profile is selected for your paper.  

- Make sure NONE is set for the Press Match field.  

  In the Input section:

- Make sure Embedded Action is set to Apply

- Make sure that your normal Photoshop working spaces are selected in the Missing Profile 		    
section for each color type.  

Channels: Prints that appear reversed or negative may be due to extra channels in the image (open the image in 
Photoshop and check, in the Channels window, that only the normal color channels appear)

Compression: Prints that appear reversed or negative may be due to extra channels in the image (open the image 
in Photoshop and check, in the Channels window, that only the normal color channels appear)

Pixel Order: For Tiff files, make sure the PIXEL ORDER setting is interleaved (NOT “per channel”).  This can be 
check in the Photoshop SAVE dialog.

Corrupt File: Rarely, a corrupted file can print with distorted results.  Make sure to try printing a different file, such 
as one of the sample images within the TEST IMAGES folder within your ImagePrint folder.

Nozzles: You may also get this result if there is a severely clogged nozzle.  Do a nozzle check on the printer to 
ensure the nozzles are all clean.

Incorrect Printer/Paper profile: Choosing a “Phatte black” profile  when you are not using the Phatte black ink set 
can cause distorted prints, as can doing the opposite (printing with a non-phatte black profile when you ARE config-
ured for Phatte black). Phatte black profiles always have “dk” in the title--non-phatte black profiles have “mk” or “pk” 
in the title.

Prints show banding (lines)  

Nozzles: The first thing to check if you are experiencing banding issues is the nozzles of the printer.  This is by 
far the most common cause of this problem. Even one missing or incorrectly firing nozzle can cause unpredictable 
banding.  Run a nozzle check, and, if nozzles are missing or incorrectly aligned, run printer cleanings until it is cor-
rected. (Note that ImagePrint, due to its enhanced ability to render detail, may show banding due to nozzle issue 
when the standard manufacturer’s driver doesn’t).

Quality:  Giving the print more time to absorb the ink as it prints by setting the Quality to a higher number of passes 
may cure banding issues.  You can change the passes in the ImagePrint Print dialog.  Going from 4 pass to 8 pass 
will effectively double the print time.  Also, if you are set to a HS (high speed) quality mode, try a non-HS Quality to 
allow the print more time to absorb the ink.

Media Type: If your printer supports the Media Type setting (accessed via the Option button in the Print Dialog box), 
make sure you are set to a correct paper setting for your media. 
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What do Passes  (4-pass, 8-pass, etc.) mean in the Quality listing?

Many printers have the ability to move the print head over the same area of the paper, firing different nozzles each 
time.  The higher the number of passes, the more times the head will pass over the same area of paper, firing fewer 
nozzles with each pass.  In the end, passes don’t make a difference in terms of what gets put on paper--the same dots 
will be put in the same place--they will just take a longer (or shorter) time to get there. But more passes will give the ink 
droplets more time to soak into the paper.  This reduces the chances of droplets coalescing on the surface of the paper, 
which is a cause of inking problems on the print such as banding, artifacts, or smudges.  

Higher pass settings make a very significant speed difference, though--doubling the passes (say, from 4-pass to 
8-pass) doubles the print time.  So you should use a lower pass setting as long as you don’t see inking issues.

For most printers, the default pass setting that ImagePrint uses is 4-pass.

What does HS mean in the Quality Listing?

HS in the quality name means “High Speed” or bi-directional printing. In this mode, the print head will put ink on paper 
in both the directions that it moves across the page. (Non-HS mode printing only puts ink down as the print head 
moves away from its original home position).  The ultimate position and size of the droplets on the page will be the 
same in the end--HS just puts them there more quickly.

Bi-directional (HS) mode does significantly improve speed (by a factor of 2), but on some papers (typically glossy ones) 
it may not provide enough time for the ink to settle into the paper before more ink is laid down, resulting in potential 
banding, smudging or artifacts in the print.  Also the print head isn’t perfectly registered you may seen alternating pat-
terns of light and dark areas on the print.  For slower computers or connections, you may find that the printer is more 
likely to pause when printing in HS mode as it waits for more data from the printer.

As with most Quality settings, use of HS mode is a matter of using it if you see no negative results.  In most cases, it is 
perfectly fine and will double your printing speed with no loss in quality.

What Quality value should I use when printing? (2880? 1440? Photo? Best?)

The Quality values (which will be determined by the Printer/Paper profile you choose in the Color Management window) 
refer to the droplet size used by the printer.  Typically, these are numeric values that refer to the number of droplets per 
inch, but for some printers the qualities modes have names instead (such as BEST, PHOTO, FINE, etc.)

Smaller droplets sizes aren’t necessarily the best mode to use.  For example, 2880 is a very fine dot, but doesn’t allow 
for variation in the droplet size on most printers, so,  it isn’t necessarily “better” than 1440 (which does allow for size 
variation) since the ability to produce variable dot sizes can make a significant difference in the smoothness of the dot 
pattern produced on the paper. 

In most cases, ImagePrint’s profiles will be made for 1440 (on some printer’s, this is referred to as PHOTO quality).  
2880 profiles may also be available, but due to the much slower print speed and dubious improvement in quality at 
normal viewing distance, they are typically made only for some gloss papers (matte papers, with their large dot spread, 
tend to lose any advantage the smaller droplet size might provide). 

Lower quality modes, like 720, may be available as well.  Generally, 720 quality produces output that’s slightly   grainier 
and more susceptible to banding.
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What Resolution (PPI) should my images be saved at for best results?

Every print driver takes all the images on a page and builds a large raster (dot) image that is sent to the printer.  
Regardless of the PPI (pixels per inch) of the images on the page, the information will be converted to the one of the 
printer’s “native” resolutions at print time.  You can set this resolution via the DITHERING DPI setting available in the 
ImagePrint Print dialog.

Note that this printer PPI is distinct from the quality that the printer is driven at.  The quality setting for the printer specifies 
the size of the droplets (typically, specified in droplets per inch) that the printer will use to render the image on the page.  
Since the printer uses multiple droplets to present each pixel of the image, the  quality that the printer is capable of doesn’t 
translate to the PPI of the image data that is sent to it.  For example, a printer might print 1440 droplets per inch, but within 

that inch, only 360 pixels of image data are represented.

ImagePrint can open images of any resolution, but it will interpolate them to the printer’s native resolution (the Dithering 
DPI) at print time.  (ImagePrint uses bi-cubic interpolation when scaling images). 

Since the RIP will interpolate the images to the native printer PPI, there’s no benefit for your images to be a  higher PPI 
than that setting.  In fact, anything above 240 PPI or so doesn’t show any improvement on ink jet printers.  (This is 240 
PPI at the printed size--if you’re scaling the image, of course, you’ll want to start with a higher resolution.)

Therefore, as long as your image is 240 PPI or above at its printed size, your prints will be at their best quality.  Giving 
us images at a higher PPI won’t hurt, but they won’t make a noticeable improvement on your output, either for photo-
graphic images.  (The exception to this rule is when your images are vector (line work) images.  Single pixel lines, when 
interpolated, may result in unwanted moire type patterning--therefore, it is often best to provide computer generated line 
work at the native resolution of the printer).  

For most printers, 360 or 300 are the standard PPIs used--you’ll see one of those by default as the Dithering DPI in the 
ImagePrint Print Dialog.  A lower setting (such as 180) may result in slightly faster processing speeds, but can show 
a slight (although typically very small) increase in “graininess”.  It is therefore only recommended that larger (5 feet+) 
images use the lower PPI settings instead of the default 360 (or 300).  At larger sizes, the slightly more grainy output 
typically isn’t noticeable, as prints of that size are usually meant to be viewed at a distance.  

Where should I scale my images--Photoshop, ImagePrint, or using a specialized program?

Because of the relatively low-resolution of an inkjet printer, it is doubtful you will see any difference between images 
scaled via Photoshop, ImagePrint or a specialized program if you are doing no more than doubling the size of the origi-
nal image. (You may want to try some sample prints utilizing different methods to find what is best for your workflow.)

One benefit of scaling images in ImagePrint is that you then won’t have to produce a “print ready” copy of the image.  
ImagePrint will scale the image “on the fly” with no need to save a 2nd copy at the desired print size.  Also, when scal-
ing the  images, ImagePrint uses bi-cubic interpolation at the final (dithering) stage of rendering it for print.  Doing the 
scaling late in the process is a benefit, as it allows all other image processing to be performed on the original (un-inter-
polated) data. 

ImagePrint does -not- currently apply any sharpening to images during scaling, which may be a factor if you are scaling 
your images more than twice their original size.  In those cases, you may wish to use Photoshop or a specialized pro-
gram like Genuine Fractals to scale your images.  (This is especially true if you are blowing the image up 4 or 5 times 
it’s original size. )

Again, it is often best to print some samples using different methods of scaling/sharpening to ensure you’re not doing 
more work then you have to to achieve the same print quality.
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What is gloss differential?

Gloss differential is the effect of inked areas of a print having a different gloss (or shine) then non-inked portions.  
The problem is predominately seen on glossy papers, and is usually noticed as white areas of the page appearing 
more shiny then the non-inked areas when the paper is viewed at a slight angle.  Matte paper does not show this 
effect to any noticeable degree.

Gloss differential has been reduced with newer ink sets on some printers (the inks maintain a gloss that more 
closely matches that of the paper).

Laminating, or spray coating, the print will eliminate gloss differential.

What is bronzing?

Bronzing is often described as a golden or bronze “sheen” seen on a print where the dark areas take on a flattened 
appearance when the media is held at an angle.  It only occurs on papers with a gloss coating (not on matte) and 
is not visible when the print is viewed directly (straight on).  It is strongest in the dark areas of the print and is most 
noticeable with black and white output, where heavy use of black ink occurs.

Some Epson printers employ a lite-lite black ink that greatly reduces the bronzing effect. Because of this, 
ImagePrint’s phatte black option (which makes no use of the lite-lite black) may show more bronzing on black and 
white prints on glossy papers than non-phatte black prints. 

Laminating or spray coating the print will eliminate the bronzing effect. 

What is metamerism?

Metamerism is the phenomenon of ink jet prints having different color casts when moved from one light source 
to another.  For instance, taking a print from daylight to fluorescent light will cause the print to often appear more 
warm.  Metamerism is a product of the colored inks so is much more prominent on color prints then black and 
white.  ImagePrint’s black and white printing (using a “gray” printer profile), makes use of very little color ink and 
shows virtually no metamerism.  

For color printing, ImagePrint provides printer profiles optimized for different lighting conditions.  This can help to 
optimize your output for the viewing environment it will be displayed in--you can see which light a profile is made for 
by looking at the abbreviation at the end of the profile name, such as “DAY” for daylight, or “CWF” for “Cool White 
Fluorescent”.  More information on profiles names  can be found later in this guide in the entry entitled: What do 
the profile names mean?
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Profiles and Color Management
Problems and questions related to ICC/ICM color management and profiles are discussed here

My printed colors/tones don’t match my display

Printed output not matching the display on the monitor is one of the most common frustrations in any workflow.  
Following are the most common causes of this problem and their solutions.

Remember---ImagePrint is always soft proofing, meaning it is passing its display through the printer profile.  Your 
display in ImagePrint should look close to your print if you are using a calibrated monitor and your settings are cor-
rect.  As a test, always look at the display in ImagePrint and compare it to the print--don’t just compare it to the 
display in Photoshop.  For soft proofing issues within Photoshop, make sure to also consult the entry in this guide 
entitled: Photoshop doesn’t match my output (softproofing)).

• 	 NOZZLES: First and foremost, make sure you have performed a nozzle check on the printer and that no nozzles 
are clogged.  Clogged nozzles are the number-one cause of color issues.

•	 Incorrect ImagePrint Color Settings: Double-check your color management settings in the ImagePrint Color 
Management window (available under the Image Menu).  Chapter 6 of the ImagePrint users manual discusses 
Color Management settings in detail, but here’s a check list:

	   In the Output section of the Color Management window:

-	 Make sure you have a valid Printer/Paper profile in the Printer/Paper field for the media you are printing 
on.  If the proper profile is not available, use the Profile Manager to download the correct one from our 
web site.

-	 The PRESS MATCH PROFILE should be NONE unless you are intentionally trying to match your 
output to a PRESS.  In almost all cases, when printing photography, leave this setting at NONE.

-	 The Colorized B/W field is only used if you are printing an image with mostly neutral data, and some 
color portions you wish to use a color profile for.  Otherwise, leave this setting at NONE.

	   In the Input section of the Color Management window:
-	 The Embedded Profile Action should be set to APPLY for the vast majority of workflows.
-	 The Colorimetric Intent should be either PERCEPTUAL or RELATIVE Colorimetric for each of the image 

types listed (RGB, Grayscale, CMYK, LAB)

-	 Make sure to choose a standard working space (NOT A PRINTER PROFILE) in each of the fields within 
the Missing Profile/Uncolormanaged section.  Generally, these should match your standard working 
spaces in Photoshop. (For most users, Adobe 1998 is used in the RGB field, and Gray Gamma 2.2 is in 
the Grayscale field).

•	 Uncalibrated Monitor: Make sure you have calibrated your monitor before attempting to match your screen to 
your prints.

•	 Two Monitors: If you are using a two monitor system, it is important to understand that ImagePrint will only rec-
ognize the monitor profile for your System monitor.  Therefore, if ImagePrint’s display is residing on a secondary 
display, the monitor profile may be incorrect.  It may be necessary to designate the secondary monitor profile as 
the System monitor profile to have ImagePrint show colors properly on the second monitor.

•	 Too Dark:  If hues are fine, but overall darkness is the issue, it’s likely you are using an LCD monitor and the 
screen is too bright even if your monitor has been calibrated.  When LCDs became the norm, this  became a 
common problem as LCD’s are factory set in almost all cases to be brighter than CRTs, and calibrating doesn’t 
bring the gamma down enough. (This is chiefly due to LCDs having trouble rendering deep shadow detail--

Continued on next page
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increasing the brightness opens up the shadow display at the expense of a too bright display).  The solution is to 
manually tone down the brightness with the monitor’s brightness controls to match the print.

•	 Incorrect Soft Proofing: ImagePrint’s display always soft proofs, so it should always match your print reason-
ably well on a calibrated monitor.  Photoshop’s display only soft proofs when you have set Photoshop to do 
so--otherwise, it will display the image with absolutely no allowance made for the paper and inks you are using, 
displaying the image the same for a watercolor paper as it would for a high-gloss film.  Check the section later in 
this guide entitled: Photoshop doesn’t match my output (softproofing) for details on soft proofing with Photoshop.

•	 Improper Color Management:  If your images are not color managed correctly, your output will not be correct.  
To avoid this, a basic understanding of color management principles is important, but often problems can be 
avoided by simply making sure you are aware of the color space the images are in at every step in your work-
flow, and that your images are never incorrectly assigned the wrong source profile.  
 
For example, if opening an image without an embedded profile in Photoshop, you will typically be prompted 
on how you wish to color manage the image.  If you choose “Use my current working space” and your current 
working space is not the one the image was created in, Photoshop will incorrectly assign the color space to the 
image, resulting in distorted colors.  Sometimes, printing with the standard manufacturers driver will not show the 
problem, as those drivers often “dumb-down” the image to an sRGB color space at print time, but can show up 
when printing in a properly color managed RIP like ImagePrint.  More information on Color Management is avail-
able in chapter 6 of the ImagePrint manual.

•	 Wrong Lighting: The ink used in inkjet printers always exhibit some level of metamerism (the tendency to look 
different under different types of light).  Make sure to use the right profile for the lighting you are viewing your 
color prints in (for example, a print made using a profile with “day” in the title is optimized for daylight viewing).  
For more information, consult chapter 6 of the ImagePrint user’s guide.  For information on the profile names, 
check the entry entitled What do the profile names mean later in this guide.  (Grayscale printing with a ColorByte 
GRAY profile is much less susceptible to metamerism due to the greatly reduced used of color inks).   

•	 Wrong side of the paper: Sometimes it’s hard to tell which side of the paper to print on.  Make sure you are 
printing on the coated side (as a test, touch a wet finger to each side of the paper--the stickier side is usually the 
coated (printable) one).

•	 Phatte or non-phatte: For some printers, ImagePrint supplies “phatte” profiles, made for printing in our special 
phatte-black mode.  These profiles will always have “dk” in the title instead of the usual “pk” (photo black) or 
“mk” (matte black).  If you are not using a phatte black ink cartridge in your printer, do not use a profile with “dk” 
in the title.  Alternatively, if you ARE set up for phatte black, ONLY use profiles with “dk” in the title.

•	 Older gray profile: If using ImagePrint 7 (or 6.x), “gray” printer profiles will have “6” in the title.  Older gray print-
er profiles (without the “6”) were made for earlier versions of the software (5.6 and below) and will give incorrect 
results with version ImagePrint 7 (or 6.x). 

•	 Somebody else’s printer profile: Printer profiles don’t just characterize paper and ink.  They are a fingerprint 
of how a RIP or driver lays down ink.  Therefore, never use a profile made for another RIP or the manufacturer’s 
driver with ImagePrint (or vice-a-versa) or incorrect colors will result.  If you create your own profiles for use with 
ImagePrint, make sure to create them by printing an un-color managed profiling target from ImagePrint accord-
ing to the instructions in the ImagePrint Manual’s Appendix.  

My printed colors/tones don’t match my display
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What do the profile names mean? 

ImagePrint’s profiles start with the PRINTER NAME (abbreviated), followed by the INK SET used for this 
profile (mk is matte black, pk is photo black, dk for “Phatte Black” (dual black) mode)).  Next may come the 
VERSION LETTER of the driver (currently “b”) they are made for, then the PAPER TYPE (sometimes very 
abbreviated) and the QUALITY at which they were made (if no quality appears in the name, assume 1440 for 
most printers.  The Quality setting refers to the droplet size the printer will use, as well as the number of pass-
es and HS (high speed) mode.). You may also see a number (i.e. “6”) indicating which version of our profiling 
target (not which version of Imageprint) was used to generate the profile. The designations at the end of the 
name refer to the lighting temperature the print will be best suited for. 

The following entries describe the Quality and Lighting designations in more detail.

What are the LIGHTING designations within the profiles?

The designations at the end of the printer/paper profile name refer to the lighting temperature the print will be 
best suited to be displayed in.  

Inkjet printers often exhibit metamerism  (which is the characteristic of a print changing its appearance as it is 
moved to different lighting conditions) so ColorByte gives you a few choices to enable you to pick the condi-
tions that most closely will match where the print will be viewed.  (Although you can’t always know where a 
print will be viewed, having the ability to choose the temperature can make a big difference.  If you know your 
print is going to viewed in a museum that uses Tungston lighting, you can pick the profile that will show it best 
there.  If you are planning on hanging your print near a window, the Daylight profile would show it best.).

Not all lighting temperatures will necessarily be available for each profile made.  And, for most profiles, only 
the EDAY, F2 and F3 profiles are included on the cd.  (The ETUNG and ECWF profiles can be downloaded 
from the ColorByte profile repository at www.colorbytesoftware.com.)

The current temperature abbreviations are:

ETUNG	 Tungsten

EDAY	 Daylight (Most printer drivers only supply daylight optimized profiles, so this type  may 
be best for an “apples to apples” comparison of ImagePrint prints to prints done via other 
methods). 

ECWF	 Cool White Fluorescent

F2 	 Fluorescent, alternate version  (this version is a bit less warm than our standard ECWF 
profile, some people, especially portrait photographers, prefer it).  This temperature was 
previously abbreviated with “ECWF2”.

F3	 Mixed lighting (daylight with fluorescent).  This the best profile to use for general lighting 
conditions, such as that found in offices.  (NOT AVAILABLE FOR ALL PRINTERS and 
PAPERS)

www.colorbytesoftware.com
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ImagePrint doesn’t match my Photoshop display! (SoftProofing) 

This entry addresses the use of soft proofing within Photoshop to ensure the Photoshop display is compensating 
for the printer, ink and media being used when printing.  For problems with the appearance of the prints them-
selves, consult the portion of this guide entitled My prints don’t match my display.   

If Colored Images don’t show the same colors as Photoshop’s display...

By default, Photoshop does nothing to compensate for how an image can print on a given output 
device.  It has no idea of the printer’s gamut, or the media (matte or gloss), or what ink you are 
using, or even the capabilities of the RIP--even though all of those factors have a tremendous 
affect on what colors and densities you will be able to print.   Photoshop just displays the image as 
best as it can within the gamut of the monitor.  It’s therefore no wonder that Photoshop won’t auto-
matically match the output of your printer, especially if you are using a RIP (like ImagePrint) that 
maximizes the output capabilities of the device rather than restrict it to a monitor-like color space.

You can, however, tell Photoshop to use ImagePrint’s color profiles when creating its display, allow-
ing you to work in a Photoshop environment that reflects more closely how ImagePrint will print 
your files.  This is called Soft Proofing, and is done via the PROOF SETUP feature of Photoshop.

To cause Photoshop to pass its display through ImagePrint’s printer profile, you must first copy the 
printer profile you are using in ImagePrint into the color profile folder used by Photoshop. 

The ImagePrint Profile Manager can do this for you.  Just choose the profile on the left side of 
the profile manager window, then choose “Install profile for Photoshop soft proofing” from the File 
menu.  For information on the Profile Manager, check out the Color Management section of the 
ImagePrint Users manual.

If not using the Profile Manager, you can copy the profiles in to place manually by right-clicking 
them, and choosing “Install” in the menu that appears.

Once in place, this profile can be selected within Photoshop via Photoshop’s Proof Setup option.  
By choosing View->Proof Setup in Photoshop, then clicking the CUSTOM button, you can choose 
the Imageprint profile, causing Photoshop to bring it’s display within the gamut of the printer/paper/
ink and RIP.  

Note: There are other options within the Proof Setup window that may or may not have an effect 
on matching your output (such as simulate paper white).  The best way to determine which fea-
tures to turn on is to print a sample image from ImagePrint, then compare it to the screen display 
of Photoshop with Proof Setup in effect.  Try the different options, and use the ones that cause the 
display to most closely match the print.

Note: If you find that ImagePrint shows more shadow detail than you are used to in Photoshop, you can increase the 
darkness of the prints, at the possible expense of losing some shadow detail via the Shadow Point Compensation 
slider, located in the Output section of the Color Management window. Note that setting the INTENT for the 
colorspace of your image to RELATIVE COLORIMETRIC (within the Bitmap section of the Color Management win-
dow) will make the Shadow Point Slider’s effects much more dramatic.

Continued on next page
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If Grayscale images don’t look the same in Photoshop as in ImagePrint...

For grayscale printing, Photoshop’s Proof Setup cannot be used with ImagePrint’s current grayscale pro-
files, as Photoshop does not recognize the format of those profiles (this may change in the future).  In 
that case, Photoshop Adjustment Layers can be used to simulate ImagePrint’s output in Photoshop.  
Here’s the procedure to follow:

•	 Print an image through ImagePrint, then open that image within Photoshop.  

•	 Choose Image->Curves from the Photoshop menu. 

•	 Adjust the curve to match your ImagePrint output.  

•	 Once you have a curve that causes the on screen image to match the print, click the Save button 
within the Curves dialog box, and save the Photoshop curve as an adjustment layer (you may 
wish to give it the name of the media you are matching).  

•	 You can create multiple adjustment layers in this way, each characterizing a different media out-
put of ImagePrint.  

•	 To enable/disable a particular adjustment layer, simply click the layer visibility icon (an eye sym-
bol) within the Layers palette of Photoshop.  This will allow you to work in a Photoshop environ-
ment that simulates how ImagePrint will print for that particular media.

Important:  When saving the image, you should make sure that none of these custom adjustment 
layers are enabled in the layers window (the “eye” icon should not be beside any of them).  This 
will ensure that the information in that layer is not saved with the image, which would be unde-
sirable as the adjustment layer is used to adjust the Photoshop preview only, and should not be 
applied to the image data itself.

Where can I put profiles to have Photoshop see them (for use in Soft Proofing?) 

Color profiles must be copied from the Color folder, which is located in the ImagePrint folder into the folder that 
Photoshop uses for 3rd party color profiles.  

The ImagePrint Profile Manager can do this for you.  Just choose the profile on the left side of the profile man-
ager window, then choose “Install profile for Photoshop soft proofing” from the File menu.  For information on the 
Profile Manager, check out the Color Management section of the ImagePrint Users manual, or consult the entries 
related to the Profile Manager elsewhere in this guide. If not using the Profile Manager, you can copy the profiles 
manually. The location they should be placed in is:

On Macintosh OSX the folder is:

  /library/application support/adobe/color/profiles

On Windows the folder is:

 /winnt/system32/spool/drivers/color

ImagePrint doesn’t match my Photoshop Display (continued)
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How do I achieve consistent Color Management

ImagePrint is a tightly color managed application.  If you observe proper color management techniques in your 
workflow, your results will be outstanding, but, by the same token, incorrect color management can lead to 
unsatisfactory output.  In fact, you are more likely to see the negative results of incorrect color management in 
ImagePrint than in less advanced RIPs—just as correct color management will give you superior results to  those 
other RIPs.

Following is a brief discussion of some color management issues that often come up when wrestling with a 
achieving proper output.  For more details on ImagePrint’s use of profiles and color management, see chapter 
6 of the ImagePrint users guide.  There are also many books on the subject--Bruce Fraser’s “Real World Color 
Management” is one that many have found invaluable.

ICC (or ICM) color profiles define color spaces.  Color spaces define the full range of color for an image or 
device.  

In a color managed workflow, all an image’s potential colors (gamut) are defined by a color space determined 
when the image was created or edited.  This is the source space of the image.  

Your printing conditions will also be defined by a color space--one that specifies the range of colors that can be 
produced by the printer on a given paper and ink. This is the output space. 

At its core, ImagePrint’s color management engine job is simply to convert the colors in your image from their 
source space to the output space of the printer/paper/ink.  Doing this in a way that preserves the original look of 
the image is the goal.  (Of course, results will be dependent on the original color space of the image, and the limi-
tations of the printer, ink and paper in reproducing those colors.)

There are many opinions as to which is the “best” source color space for images to give the best results when 
printing. Common source spaces include sRGB, Adobe 1998, Color Match RGB and Pro Photo RGB.  Detailed 
discussion of which space is the correct one for your workflow is beyond the scope of a troubleshooting guide, 
but some basic things to consider are:  	

	 •	 Smaller spaces, like sRGB, have the advantage of having fewer colors that fall outside the output space 
of the printer, so you are less likely to get surprised by colors that appear one way on the monitor printing 
differently--however, you are limiting the available gamut of colors within the images.

	 •	 Large spaces, like Adobe 1998 and Pro Photo RGB, are bigger than the printer’s gamut in more areas, so 
its likely some colors will need to be altered more severely to bring them into printer gamut at print time.  
(In fact, because these color spaces are usually also bigger than your monitor’s gamut, you likely aren’t 
even seeing some colors as they really are when viewing them on screen.)  
 
Of course, you have the advantage of a wider range of colors in the original image when using a larger 
space, which is helpful when doing color processing and image editing, as well as potentially useful if you 
plan to use the image in other ways beside printing, or archive them for future use.   
 
In any case, because colors are likely to fall out of range of the printer more readily--when printing files 
from a wide gamut source space, make sure to soft proof the image within Photoshop and make use of 

Continued on next page
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Photoshop’s GAMUT WARNING feature to compensate for colors that fall outside of the printable gamut. 
(More information on soft proofing in Photoshop is available elsewhere in this guide, in the Photoshop doesn’t 
match my prints entry.

Perhaps more important than which color space your images use is that consistent color management is observed 
throughout your workflow.  Many color-managed workflows are broken when an image is incorrectly “dumped” into 
the wrong color space, resulting in undesirable color and gamut shifts.  

This often occurs when an image is opened for the first time in Photoshop. 

When you open an image, Photoshop uses what it calls “policies” to determine the best way to handle the color 
space of the image if it doesn’t match the source color spaces Photoshop is currently using.  (You can see 
Photoshop’s current color space settings in its Color Settings window).   In most cases, Photoshop’s policies result in 
a dialog box appearing when you open an images that doesn’t match Photoshop’s current settings.  This dialog will 
ask if you wish to 1.) Use the embedded profile in the image (if it exists), 2.) Use Photoshop’s current working space, 
3.) Specify another working space, or 4.) Disable color management altogether (bad idea). 

Some images already have a color profile embedded in them.  (An “embedded” profile just means the profile that 
was used when the image was created or last edited is included within the data of the image file so programs like 
Photoshop and ImagePrint know right away what its source space is.)  In those cases, its easy for Photoshop to 
open the image into the correct color space or even to convert it into another space, since it knows the color space 
the image came from it can handle things correctly. 

It’s when there is no profile embedded in the image that things can go wrong.  In those cases, Photoshop can’t tell 
what source color space the image is in, so it is “flying blind”.  This is where you need to know the appropriate color 
space to tell Photoshop to use when it opens the image.  

For example, assume your current working (source) space in Photoshop is Adobe 1998.  If you open an image 
without an embedded profile, Photoshop will display its usual prompt asking what you want to do with this mysteri-
ous image.  If you choose “assign working RGB: Adobe 1998” and the image wasn’t originally created in that color 
space, you’ve just messed up its colors.  

The same thing applies if you choose the “Specify another profile” option, but pick a profile that the image wasn’t 
created in--Photoshop essentially dumps the image into that space, and colors get... messed up.  This is probably 
the single most common pitfall of color managed workflows--opening an untagged image into Photoshop’s current 
RGB working space when the image wasn’t created in that space. 

So...if the image doesn’t have an embedded profile, how do you know the appropriate color space? 

Generally, Digital cameras tend to use SRGB type color spaces, so that’s the one to use if in doubt for those types 
of images.  Scanner images often are best opened into Colormatch RGB or Adobe 1998.  If neither of those give 
you good results, you may have to find out from the manufacturer, or the person that provided the image, what color 
space it was created for.  

Once you have the image in the correct working space within Photoshop, you can then, if desired, convert to another 
working space doing a profile to profile conversion (typically done under the Image -> Mode menu in Photoshop).  
Since Photoshop knows where the image is coming from (source space-wise) and where it is going to, it can do a 
proper conversion, and your image should not suffer (assuming you are converting it to an appropriate color space 
for the image’s ultimate destination).

Finally, to ensure consistent color management, it is a good idea to embed the profile when saving your image from 
Photoshop via the Embed profile checkbox in Photoshop’s Save File dialog.  This will enable other applications, (like 
ImagePrint) to know the correct color space automatically for the image, and greatly reduces the risk of profile mis-
matching.

Consistent color management (continued)
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How do I get new paper profiles?

ColorByte maintains a large profile library on it’s web site.  You can access the web site via the link on our support 
page, but the best way is via the Profile Manager.  The Profile Manager is an easy to use utility that can be used to 
find and download profiles.  It will download them directly to the ImagePrint color folder, so you don’t’ have to manu-
ally put them in place.  It also can perform many extra functions, such as displaying the name of the paper the profile 
each profile is made for, putting the profiles in the right spot for Photoshop to use for soft proofing, and removing any 
unwanted profiles from your ImagePrint color folder.  For more information on the Profile Manager, consult chapter 
6 of the ImagePrint User’s Manual, consult the Profile Manager’s HELP menus,  or check out the following entries 
related to its use.

Where do I get the latest version of the Profile Manager?

The Profile Manager is included in all 7.0 installers and will be installed into your ImagePrint folder: 

 Default location:   /Applications/ImagePrint/Profile Manager

We do update the utility from time to time.  The latest version is always available from our Web Site.  By going to the 
SUPPORT page at www.colorbytesoftware.com you will find a link in the DOWNLOADS section of the page for the 
Profile Manager for both the Windows and Mac version.  Click the link to have the Profile Manager downloaded to 
your computer (for Mac users, the file will be a disk image (dmg) file--double-click it to mount the disk image, then 
drag the Profile Manager application to the folder of your choice).

Downloading/accessing profiles is slow

ColorByte’s web site, installers, updaters, and profiles are constantly being downloaded, and at certain times the vol-
ume of traffic can cause access speeds to suffer.  Try downloading at another time.

The Profile Manager doesn’t launch!

Problems with the Profile Manager launching are rare--usually they are due to a file in your ImagePrint COLOR folder 
that is not supposed to be there--a sub-folder, or a non-profile.  Only ICC/ICM profiles should be in your ImagePrint 
COLOR folder, and any other files can cause the Profile Manager to “hang” at launch.  To correct the problem, open 
the Color folder from its location in your ImagePrint folder and remove any non-profiles.

www.colorbytesoftware.com
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The Profile Manager launches, but is not working correctly

Can’t log in: If you can’t log on to the ColorByte Profile site, it may be due to a firewall or other network setting 
on your system.  Disable any internet access related software and see if that corrects the problem.  

No profiles shown: If the Profile Manager is not showing profiles on the right (remote) side of it’s interface, make 
sure the “View All” profiles checkbutton is selected in the top portion of the Profile Manager window.  Also, try 
deselecting the “Show Installed Printers Only” button. 

Reset the preferences: Some problems can be corrected by resetting the Profile Manager preferences file.  
Profile Manager 1.8 and later have an option “Delete Settings and Restart Profile Manager” in its SETTINGS win-
dow (accessed from the File Menu) for this purpose..

Reinstall: If all else fails, try re-downloading the Profile Manager via the instructions earlier in this guide: Where 
do I get the latest version of the Profile Manager? Overwrite the old profile manager with the newly download-
ed one and see if the problems go away.

I downloaded a profile but don’t see it in ImagePrint’s printer/paper profile list

Restart ImagePrint: Make sure you have restarted ImagePrint since downloading the profiles--ImagePrint does 
not automatically detect newly added profiles until it is restarted.

Pick the right printer: ImagePrint 7.0 only shows profiles that are valid for the currently selected printer--make 
sure, in ImagePrint, the printer you have selected (in the upper left hand corner of the ImagePrint main window) is 
the right one for the profiles that you downloaded.  Be careful that you download the right profiles, too--it is easy 
to accidently download profiles for an “X880” printer instead of an “X800” printer, for example.

Look for the description, not the profile file name: When downloading profiles, the Profile Manager displays 
the profile’s file name in its list.  However, within ImagePrint’s Color Management window you will be seeing the 
internal description of the profile, which may differ significantly from the file name (the file name tends to be more 
abbreviated due to constraints in the number of allowed characters).  Remember, the Profile Manager also shows 
the profile description of the currently selected profile at the bottom of the profile listing.
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I can’t find the paper profile I need

First, make sure to use the Profile Manager to check our site for the profile.  Instructions on use of the Profile 
Manager are contained in chapter 6 of the User’s Guide, or within the Profile Manager’s HELP menus.

If you don’t see a profile for the paper you are using on the ColorByte Profile site, we may not have it.  Send an 
email to the ColorByte Support dept at support@colorbytesoftware.com with the exact paper name, the printer 
you plan to use the profile with, the black ink you are using if applicable (i.e. photo or matte black) and your 6-dig-
it dongle number.  We will check to see if we have the profile available (maybe we just haven’t uploaded it yet)--if 
not, we may ask you to send us some of it so we can generate a profile.

ColorByte may generate profiles for free if: 

We don’t already have a profile available

The media you wish to have profiled is a valid one for your printer

You can supply us with some of the paper (typically the equivalent of 3 11x14 sheets or larger per profile--6 
if you need both gray and color profiles) in perfect condition to use for the generation of the profile.

IMPORTANT: Even if the above applies, we do not create profiles for uncoated papers, transparencies, or most 
“unusual” media such as metals.  Profile generation times vary greatly depending on ColorByte’s volume, but typi-
cal turn around time is about two weeks.  

In some cases, rather than get samples of the media, we will ask you to output our profiling target and send it to 
us--ColorByte will let you know exactly how to do that if it is necessary.

mailto:support@colorbytesoftware.com
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PTA (Print through Applications) Issues
For issues specific to the Print through Applications option, please see the PTA chapter of the 
User’s manual, located in your ImagePrint folder or on the ColorByte support page at www.color-
bytesoftware.com.  Trouble-shooting information is located at the end of the PTA section.

www.colorbytesoftware.com
www.colorbytesoftware.com
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AutoPrint Issues
Solutions to problems with AutoPrint, the hot folder utility, are listed in this section

AutoPrint lays out images, but they never go to the spooler

Check the TRIGGER settings, in the GENERAL SETTINGS section.  AutoPrint will only send the current lay-
out to the spooler when the specified trigger(s) are met.

AutoPrint jobs print with the wrong colors

Make sure that you have chosen your Color Profile settings correctly within the COLOR SETTINGS window.  
These settings follow the same rules as the Color Management window within ImagePrint itself, so make sure 
to consult chapter 6 of the ImagePrint users guide for details on proper color management settings.

AutoPrint jobs show an error in spoolface

Consult the entry earlier in this guide entitled SpoolFace error codes to track down the cause of the error.  
Just like with ImagePrint, problems with color management, or problems with the files being printed (such as 
compression being used when saving them) can cause errors at print time.

AutoPrint doesn’t show all my profiles in its Color Settings window

Unlike ImagePrint, AutoPrint will only show profiles that have an “.icm” or “.icc” extension in their file name.  
Rename the profiles to have that extension to have them show up in AutoPrint.
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AutoPrint won’t launch 

•	 Make sure that both the AutoPrint file, and the TOOLS folder, are in the ImagePrint folder.  They can not be in a 
sub-folder within the Imageprint folder, but instead have to be directly in the ImagePrint folder.

•	 Corrupt profiles in the Color folder may make AutoPrint fail to launch. Remove any recently added profiles and see 
if that corrects the problem.

•	 Make sure your launching AutoPrint from your ImagePrint HOST computer.  AutoPrint only can be run from the 
ImagePrint HOST (the computer with the dongle) NOT a Client.  (To use AutoPrint across a network, simply run it 
on the HOST computer, and mount the Hot Folder(s) on the remote machines.  Users on the remote machines can 
simply drag images into the mounted hot folders to have AutoPrint access them on the Host.

•	 If AutoPrint’s preference files have gotten corrupted you may have trouble launching.  You can delete these files 
from their location in the “/Applications/ImagePrint/TOOLS/AutoPrint” folder.   The settings file is called “autoprint.
txt”.  Deleting it may solve the problem, but you will need to manually re-set your AutoPrint settings.

•	 If you have been doing a LOT of printing with annotations, you may have accumalated too many temp files in the 
TEMP folder, within the ImagePrint folder.  If there are thousands of files in this folder, delete them and that may fix 
the problem.

AutoPrint layouts show a border along the edge

This is usually when you are set to BORDERLESS printing mode.  When in borderless mode, the printer will “over-
print”, causing 1/8 inch or so of each image to fall off the page, which can result in an unexpected border or cropping.  
Using the “Optimize Margins for Borderless” feature, in the Margins section of the Layout Settings window, should 
correct the problem by offsetting your layout to ride along the edge of the page.

 

I Can’t find AutoPrint

AutoPrint is included in all Window’s installation cd’s, but is not included in ImagePrint installer downloads (to keep 
the size of the download small).  You can always download the latest version of AutoPrint from ColorByte’s web site 
though.  By going to the SUPPORT page at www.colorbytesoftware.com, and choosing the FTP link, you will access 
our general FTP site.  The archive: AutoPrint for Windows will be listed within the AutoPrint Files folder there.  
Download it, then unzip the archive.  You will then have a folder containing the AutoPrint executable.  Place that file in 
your ImagePrint folder, and you are ready to double-click AutoPrint to launch it.  Note that the first launch of AutoPrint 
may take a minute or more to load, as it is creating some necessary files.  Subsequent launches will be much quick-
er.

www.colorbytesoftware.com
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I found an AutoPrint feature that’s not in the Manual! 

As a dynamic, scripted application, AutoPrint is updated frequently, and the ImagePrint documentation often can’t 
keep up with new features that are added.  Virtually all features in Autoprint do have “balloon help” associated with 
them.  By hovering your mouse over the feature for a few seconds, a window containing a brief description will 
appear (make sure that balloon help is turned on in the View menu of AutoPrint).  If that isn’t enough, please email 
colorbyte for a description of the feature.

How do I access different printers and/or hot folders with one copy of AutoPrint?

AutoPrint’s QUEUE feature allows you to have a virtually unlimited number of hot folders, each with it’s own group of 
settings.  Remember, each printer and/or queue should have a unique hot folder chosen for it.

By launching AutoPrint multiple times, and picking different printers and queues, you can monitor different hot fold-
ers at the same time.  To automate the process, use the “Create Auto-Launch Shortcut” feature in AutoPrint’s FILE 
menu.  That will create a shortcut on your desktop that will launch AutoPrint and automatically switch to the printer 
and queue that the shortcut was made for.


